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Online Resources 
 
IVM Home Page - www.nch.com.au/ivm/index.html 
       
IVM Frequently Asked Questions (FAQ) Page - www.nch.com.au/ivm/faq.html 
       
Example IVR Setup Files - www.nch.com.au/ivm/examples.html 
       
Plugins (List of prepared plugins for download) - www.nch.com.au/ivm/plugins.html 
       
Recommended voice modems and telephony boards - www.nch.com.au/ivm/modems.html 
       
Recommended free VoIP (SIP) line services - www.nch.com.au/iv/talk/sip.html 
       
Software Development Kit (SDK)  - www.nch.com.au/ivm/sdk.html 
     (Write plugins and link your s/w to IVM using the API)  
       
Command Line Arguments - www.nch.com.au/ivm/sdk.html 
       
ISO/IEC13714 Summary for IVM Developers - www.nch.com.au/ivm/iso13714.html 
     (Standard for well designed IVR menu structures) 
 
 
 
 
 
Technical Support 
 
If you have difficulties using IVM please read the applicable topic before requesting support. If 
your problem is not covered in this manual (including the Troubleshooting Problems page)  
please view the up-to-date IVM Online Technical Support at www.nch.com.au/ivm/support.html. 
If that does not solve your problem you can contact us using the technical support contacts listed 
on that page. 
 
 
 
 
 
Software Suggestions 
 
If you have any suggestions for improvements to IVM or suggestions for other audio software 
that you might need please contact our programmers using www.nch.com.au/suggestions. Many 
of our software projects have been undertaken after suggestions from users like you. 
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Quick Start Guide 
 
Thank you for installing IVM. 
 
For a quick step-by-step guide to setting this software up, please see the following Quick Start 
sections of this manual. 
 
I want to use IVM... 
 
�       as an Answering Machine. 
�       to display and log Caller ID. 
�       to transfer calls to different people (Call Attendant). 
�       as an office Voice Mail System (1 - 10000 voicemail boxes). 
�       to accept Payment by Phone. 
�       as an InfoLine (to play recordings on demand). 
�       to Record Dictation over the phone (DialDictate). 
�       to Record Telephone Calls. 
�       to automate Outbound Message Calls. 
�       to use Call Attendant and Voice Mailboxes with Axon. 
�       for other automated Interactive Voice Response Systems. 
 
If you have any problems when attempting to setup IVM, you can view the associated Help Page 
online at any time by pressing <F1>. If IVM does not seem to be working properly the page 
Troubleshooting Problems has tips for finding and resolving common problems. 
 
 
 
 
 

Quick Start Guide - Answering Machine 
 
Step 1: Call your phone number and record a test message. If this does not work it means 
you don't have the correct hardware or there is a problem with your drivers. See 
Troubleshooting Problems for how to fix this. If you don't have hardware yet, you can 
continue to test IVM using the Call Simulator (from the File menu).  
 
The up-to-date recommended hardware (voice modems and professional telephony boards) is 
listed at www.nch.com.au/ivm/modems.html. You could also always sign up with a VoIP service 
for a VoIP line and avoid hardware altogether - see Using Voice over IP (VoIP) . 
 
 
Step 2: Change the Out-Going Message. If you want to change the Out-Going Message, use 
the menu OGM -> Properties then click "Change Message Audio" and select "Record" or 
"Synthesize Speech" to change the greeting. 
 
Step 3: Setup the Default Mailbox Properties. Select Mailbox -> Properties from the menu. 
IVM has many advanced options that can be enabled for the mailbox. These include Call 
Screening, Message Forward (by email or to a phone number), Remote Access and more. Click on 
the Help button from Mailbox Properties for a full description of each feature. 
 
There is much more to the IVM than just an Answering Machine. You should explore the options 
on Settings, OGM Properties and Mailbox Properties and of course read this manual. We hope you 
will be surprised by some of the powerful tools we have included in this software package. 



 

 

Quick Start Guide - Caller ID Display 
 
Note: If you want to use IVM as an Answering Machine as well as a called ID display, please see 
Quick Start Guide - Answering Machine  first. 
 
Step 1: Check Caller ID is Supported. To use CID, your hardware (voice modem) must 
support it (check the manual). Your telephone company must also offer caller ID (some require 
you to pay for it). If you are using a PBX phone system then that system must support caller ID. 
 
Step 2: Turn off Answering. If you don't want IVM to answer calls (but only display CID) press 
Ctrl+F to turn it off. 
 
There is much more to the IVM than just an Caller ID Display. You should explore the options on 
Settings, OGM Properties and Mailbox Properties and of course read this manual. We hope you 
will be surprised by some of the powerful tools we have included in this software package. 
 
 
 
 
 

Quick Start Guide - Call Attendant 
 
IVM can play a menu that lets callers select whom they want to speak to and then transfer or 
announce the call to that person. To setup these systems you need to have a better 
understanding of the way IVM works. We recommend you start with the manual page General 
Concepts (OGMs / Mailboxes / Messages etc. You should also test IVM and your hardware 
first using the basic answering machine functionality. 
 
Call Attendant with a PBX (phone key system) 
 
Step 1: Download one of the example IVR files from www.nch.com.au/ivm/examples.html. 
 
Step 2: Load the IVR file using the menu File -> Load -> IVR Program File. 
 
Step 3: Run the Call Simulator (File -> Call Simulator) to hear the basic structure. Note: the 
transfers themselves do not work on the Call Simulator. 
 
Step 4: View / Print the OGM Report so you can see the general structure. Use the menu OGM -> 
Open Out-Going Messages Report. You can print the report if it makes it easier. 
 
Step 5: Use the OGM List as a base (menu OGM -> Open Out-Going Messages List) and modify 
the properties of the OGMs as required for your system.  If you don't understand any setting 
press <F1> from the OGM Properties box to open the reference manual. Use the Call Simulator 
to test changes. 
 
To transfer calls with a PBX, the PBX must be able to transfer calls from an ordinary phone 
extension using a dial string starting with a flash hook. If you are not sure how to do this with 
your PBX refer to its manual (or the supplier). You should not proceed until you have plugged in 
an ordinary analog phone into an extension and have received and transferred a call yourself. 
 
Step 6: On the Transfer / Record tab of Settings enter the sequences that your PBX requires to 
transfer calls. For more information, please see Transferring Calls. 
 



 

 

Step 7: Test your system using the phone. If you have problems when transferring see 
Troubleshooting Problems. If you have problems with your menu structure the Most Recent 
Call Logs (File -> View or Print Logs) can be useful to see what happened. 
 
For more information about work with PBXs please see Connecting to telephone key systems 
or PBXs. 
 
 
Using your Phone Company to transfer calls externally 
 
If you don't have a PBX you can use a service of your phone company to transfer calls externally. 
The steps are the same as with a PBX except you may need to modify your Transfer Settings (on 
the Transfer / Record tab of Settings). 
 
Some companies have a transfer service which lets you transfer calls with a dial sequence usually 
starting with a flash-hook. (Telstra calls this service Business Links but each company has their 
own name). If so, subscribe to the service and carefully follow the instructions. Make sure you 
can initiate a transfer manually using a regular phone before attempting to use the IVM then 
enter the settings in the Transfer Settings. 
 
If your phone company does not offer this service, you can achieve a similar result using a 3 way 
call conference service if that type of service is available. Setup the Transfer Settings as if you 
were making a transfer and also tick the "Simulate Call Transfers as 3 way conference calls". 
 
Using attendant type menus on a single line (eg. Home or Small Business use) 
 
This is called pseudo-transfer. The call is not really transferred. IVM plays an "on-hold" message 
while announcing who the call is for through the speakers. When you pick up a call you just press 
# to 'take' the call. Otherwise IVM can be set to send the call to a voice mail box after a set time. 
 
The summary instructions are:  
 
(1) Create an OGM (the "Hold OGM") with an message of say "please hold the line" then say 3 
minutes of "hold" music".  
 
(2) Under the Key Response tab of the Hold OGM's Properties have: Press '#' - Hang-up 
(immediate).  
 
(3) Under the Advanced tab of the Hold OGM's Properties, tick the "announce call through 
speakers" option and browse to find a suitable wav file (ideally this could say... "Call for ...").  
 
(4) Under the Key Response tab of the Main OGM's Properties have Press 1 - "Go to OGM... Hold 
OGM". When a caller presses 1, you will here the account file (eg. Call for Jay") through your 
speakers while the caller hears hold music. To 'take' the call simply pickup the phone and press 
#. 
 
Transfer with VoIP Calls 
 
"Blind" Transfers with VoIP is automatic and does not require any settings. Just setup your VoIP 
line and Blind Transfers should work. See Using Voice over IP (VoIP) for more. 
 
If you are using the Axon Virtual PBX software (see www.nch.com.au/pbx) blind transfers should 
work automatically.



 

 

Quick Start Guide - Voice Mail Systems 
 
Step 1: Download one of the example voice mail IVR files from 
www.nch.com.au/ivm/examples.html. 
 
Step 2: Load the IVR file using the menu File -> Load -> IVR Program File. 
 
Step 3: Run the Call Simulator (File -> Call Simulator) to hear and test the basic structure. 
 
Step 4: View / Print the OGM Report so you can see the general structure. Use the menu OGM -> 
Open Out-Going Messages Report. You can print the report if it makes it easier. 
 
Step 5: Use the OGM List as a base (menu OGM -> Open Out-Going Messages List) and modify 
the properties of the OGMs as required for your system.  If you don't understand any setting 
press <F1> from the OGM Properties box to open the reference manual. Use the Call Simulator 
to test changes. 
 
Step 6: For each voice mail box you can change the delivery settings by selecting the mailbox and 
using the menu Mailbox -> Properties. Press <F1> in Mailbox Properties for a full list of functions. 
Popular options include using email to send messages directly to their inbox or use the transfer to 
LAN folder so messages can be checked over the computer network. 
 
Step 7: Test your system calling in from an external line. If it does not work exactly as it does on 
the call simulator then chances are you have hardware or driver problems. See 
Troubleshooting Problems for how to fix this. 
 
 
Using VoiceMail Systems with PBXs (telephone key systems) 
 
Most PBXs offer special functions to transfer unanswered or voice mail options to the voice mail 
computer running IVM. The extension that the call was for is 'communicated' with a dialed 
number at the start of the call (this is called inband signalling). 
 
If you want to setup this way, you need to read your PBX manual then modify your answer OGM 
to accept data entry of the number of digits to be entered. That data entry variable is then used 
as the name of the mailbox. You will probably need to use the 'Use special digits 
mapping function" to extract the extension number from the string. See Data Entry for 
more. 
 
For more information about integration PBXs with IVM, please see Connecting to 
telephone key systems or PBXs. 



 

 

Quick Start Guide - Pay by Phone Systems 
 
Step 1: Download one of the example credit card payment IVR files from 
www.nch.com.au/ivm/examples.html. 
 
Step 2: Load the IVR file using the menu File -> Load -> IVR Program File. 
 
Step 3: Run the call simulator (File -> Call Test Simulator, or click the <Simulator> button below 
the menu bar on the main IVM window) to hear and test the basic structure. 
 
Step 4: View / Print the OGM Report so you can see the general structure. Use the menu OGM -> 
Open Out-Going Messages Report. You can print the report if it makes it easier. 
 
Step 5: Use the OGM List as a base (menu OGM -> Open Out-Going Messages List) and modify 
the properties of the OGMs as required for your system.  If you don't understand any setting 
press <F1> from the OGM Properties box to open the reference manual. Use the Call Simulator 
to test changes. 
 
Connecting to your Payment Gateway 
 
The example credit card payment IVR only logs the payments received. You must later batch run 
the data to your bank through your normal credit card payment system. 
 
If required IVM can contact your bank directly for immediate authorisation through a payment 
gateway using a plugin (see Using IVM Plugins). Your payment gateway might be able to 
provide an IVM plugin or you can write it yourself. If your payment gateway does not provide an 
IVM plugin and you cannot program, you can request a quote from us at 
www.nch.com.au/development to write the plugin for your particular gateway. 



 

 

Quick Start Guide - Infoline Systems 
 
Step 1: Download one of the example infoline IVR files from 
www.nch.com.au/ivm/examples.html. A suitable example is the Real Estate Property Information 
Line - this can be modified for most applications. 
 
Step 2: Load the IVR file using the menu File -> Load -> IVR Program File. 
 
Step 3: Run the Call Simulator (File -> Call Simulator) to hear and test the basic structure. 
 
Step 4: View / Print the OGM Report so you can see the general structure. Use the menu OGM -> 
Open Out-Going Messages Report. You can print the report if it makes it easier. 
 
Step 5: Use the OGM List as a base (menu OGM -> Open Out-Going Messages List) and modify 
the properties of the OGMs as required for your system.  If you don't understand any setting 
press <F1> from the OGM Properties box to open the reference manual. Use the Call Test 
Simulator to test changes. 
 
Step 6: Test the system from a real external phone. If IVM does not answer or fails there is a 
chance you have hardware or driver problems. Please see Troubleshooting Problems for 
solutions. 
 
 
 
 
 
 

Quick Start Guide - DialDictate 
 
NCH Swift Sound makes a specialist program to record dictation by phone and transmit it to 
typists called DialDictate. Please download this from www.nch.com.au/dialdictate/index.html. 
 
While IVM can be setup to do the same thing, DialDictate is easier and can run 'out-of-the-box'. 
 
 
 
 
 
 

Quick Start Guide - Record Phone Calls 
 
NCH Swift Sound makes specialist programs to record phone calls. Please download the VRS 
Record System from www.nch.com.au/vrs/index.html which automatically records all your phone 
calls, or the TRx Personal Call Recorder from www.nch.com.au/trx/index.html to manually record 
calls or parts of calls. 



 

 

Quick Start Guide - Outbound Message Calls 
 
Step 1: Test that your hardware (eg. voice modem) is working well. Call your number and test 
the IVM Answers and records a message. If this does not work it means you don't have the 
correct hardware or there is a problem with your drivers. See Troubleshooting Problems for 
how to fix this. The up-to-date recommended hardware (voice modems and professional 
telephony boards) is listed at www.nch.com.au/ivm/modems.html. 
 
Step 2: Use the menu File -> Outbound Autodial Calls and enter a list of 2 or 3 test number 
separated by semi-colons (;). Return to the main screen and click 'Start Calls' and check that it 
works. 
 
Step 3: Modify your Out-Going Messages and add menus etc. as required. To do this you are 
going to need to read this manual. Start with the section Beyond a Simple Answering 
Machine and read on. 
 
Because calls on VoIP lines are much cheaper you should consider using VoIP lines if you are 
performing large numbers of calls. See Using Voice over IP (VoIP) for more. 
 
 
 
 
 
 

Quick Start Guide - Other IVR Systems 
 
Step 1: Download one of the example IVR files from www.nch.com.au/ivm/examples.html that 
closest matches what you want to do. 
 
Step 2: Load the IVR file using the menu File -> Load -> IVR Program File. 
 
Step 3: Run the Call Simulator (File -> Call Simulator) to hear and test the basic structure. 
 
Step 4: View / Print the OGM Report so you can see the general structure. Use the menu OGM -> 
Open Out-Going Messages Report. You can print the report if it makes it easier. 
 
Step 5: Use the OGM List as a base (menu OGM -> Open Out-Going Messages List) and modify 
the properties of the OGMs as required for your system.  If you don't understand any setting 
press <F1> from the OGM Properties box to open the reference manual. Use the Call Simulator 
to test changes. 
 
Step 6: Test the system from a real external phone. If IVM does not answer or fails there is a 
chance you have hardware or driver problems. Please see Troubleshooting Problems for 
solutions. The up-to-date recommended hardware (voice modems and professional telephony 
boards) is listed at www.nch.com.au/ivm/modems.html. 



 

 

Quick Start Guide - Call Attendant and Voice Mail with Axon 
 
When using IVM in conjunction with Axon virtual PBX software, IVM may be configured to handle 
Call Attendant actions on line 198 and voicemail access on line 199. That is, when an extension 
dials 199, that extension is immediately directed to their own Voice mailbox and the first waiting 
Voicemail, if any, is played for them. Axon will direct Call Attendant through to line 198. The 
default message on this Call Attendant will direct the user that they should setup their own 
message and menu system. 
 
Note: IVM has the ability to detect when Axon has been installed on the same computer. The first 
time that IVM detects Axon, IVM will download the example Axon IVR file from the NCH 
examples server. This IVR file may be downloaded at any time from the example IVR files 
download page www.nch.com.au/ivm/examples.html. Two VoIP Accounts will also be pre-
defined, VoIP Call Attendant (line 198) and VoIP Voicemail (line 199). See Quick Start Guide - 
Call Attendant for more on Call Attendant. 
 
If Axon is running on another computer from the one with IVM, IVM will need to be setup 
manually to make use of Axon. 
 
Manually setting up IVM 
 
Step 1: Download the Axon example IVR file from www.nch.com.au/ivm/examples.html. 
 
Step 2: Load the IVR file using the menu File -> Load -> IVR Program File. 
 
Step 3: From the Settings dialog (File -> Settings), select the Telephony tab. 
 
Now setup the two VoIP Accounts: 
 
The first account: 
� VoIP Account Name = 'VoIP Call Attendant' 

� Number of simultaneous lines allowed = 5 

� Full 'Friendly' Display Name = 'VoIP Call Attendant' 

� Sip Number (or User Name) = '198' 

� Server (Proxy and Domain) is set to the network address of the computer on which Axon is 

running 
� Password is set to the same password that line 198 is as defined in Axon 

� Answer OGM option set to 'Override Out-Going Message for this Line' and 'VoIP Call 

Attendant Start' is selected from the pull-down selection. 
 
The second account: 
� VoIP Account Name = 'VoIP Voicemail' 

� Number of simultaneous lines allowed = 5 

� Full 'Friendly' Display Name = 'VoIP Voicemail' 

� Sip Number (or User Name) = '199' 

� Server (Proxy and Domain) is set to the network address of the computer on which Axon is 

running 
� Password is set to the same password that line 199 is as defined in Axon 

� Answer OGM option set to 'Override Out-Going Message for this Line' and 'VoIP Call 

Attendant Start' is selected from the pull-down selection. 

 
NOTE: The “Number of simultaneous lines allowed” defaults to 5 lines. You may have to reduce 
this number to remain within the total number of lines permitted under your IVM license class. 



 

 

IVM Overview 
 
IVM is a telephone answering machine, voice mail, call attendant, interactive voice response 
(IVR) and automated call program for Windows computers with voice modems or professional 
telephony line devices. 
 
This software is an effective voice mail, call attendant, info-line or audiotext solution for small to 
medium businesses. For example, IVM can redirect in-coming calls during office hours or take 
messages for a number of voice mail boxes after hours. All calls (including those answered by 
you) are logged with date, time and caller ID. The recorded messages can be played at any time, 
forwarded to an email address, accessed via the Internet or, if necessary, saved for future 
reference. 
 
IVM can also be used very simply as a computer answering machine. Just run the install file and 
IVM will be ready to answer calls. But, when you are ready, you can explore the advanced key 
response and programming options to create a sophisticated telephone interactive response 
system. You will find many exciting ways to use IVM to provide information, serve your customers 
and save time. 
 
 
Typical Applications 
 
� Voice mail (from a single answering message to hundreds of voice mailboxes). 

� In-coming caller ID logger or display. 

� Call attendant (using the menu call transfer features) to direct calls. 

� Telephone information lines or AudioText type systems. 

� Automated telephone order taking. 

� Automated telephone surveys (using the number entry features linked to a database). 

� Credit card telephone account payment. 

� Dial in computer control or information (eg. Dial in to test security alarm or to restart server). 

� Automated outbound call systems. 

� Many more telephone related applications. 

 
 
Features 
 
� Multiple telephone line support (1 - 64 lines simultaneously). 

� Caller ID logging (even if no message is left) and optional on-screen caller ID flash display. 

� Key press menus and ability for caller to enter numbers. 

� Automatic message forward by email or upload to Internet. 

� Call transfer (subject to your phone company or PBX features). 

� Remote Access (listen to messages by dialing-in) including tollsaver. 

� Save in-coming messages as wav files (keep messages for legal/record purposes). 

� Automatic hours feature (enter your office hours and it will automatically answer after hours). 

� Unlimited (selectable) out-going messages and menus. 

� Call simulator is included so you can test your systems off-line. 

� Automated Outbound Calls to play telephone messages to a list of numbers. 

� Unlimited voice mail boxes (each with own email forward, Internet access page or remote 

access). 
� Extended message play on key press including support for wav, mp3 and a number of other 

formats. 
� Text-to-Speech voice synthesis as an alternative to recording or importing wav or mp3 files. 

� Ability to open files or run other software to process data or report information. 



 

 

� Support the open standard SIP for voice over IP (VoIP) calls. 

� Can work with most TAPI hardware to connect to phone lines. 

� Free professionally voiced greetings included. 

 
 
System Requirements 
 
� Windows 95/NT4/98/2000/Me/XP/2003/Vista. 

� Pentium 100 or above with at least 32MB RAM (higher requirements apply for multiple line 

installations). 
� TAPI compliant (100%) telephony device. This includes most voice modems 

(95/98/Me/2000/XP only) or a professional telephony card (eg. CAHTA, CallURL, etc.). 
� Hardware Lines: TAPI compliant (100%) telephony device. This includes most 

voice modems or a professional telephony card (eg. CAHTA, CallURL, etc.). 
� VoIP Lines: Any SIP RFC3261 compliant sip service (free services are available) 

or the Axon Virtual VoIP PBX (see www.nch.com.au/pbx). 
� [Optional] Internet Access [to forward by email or VoIP lines] 

� [Optional] Website (on local or remote server) [for Internet Access Pages] 

 
Caution: If you intend to use IVM with a voice modem, please note that there are many voice 
modems on the market with defective TAPI wave / voice drivers. Please install the software and 
check your modem works before you rely on it. If it does not work properly, check Telephony 
Hardware (TAPI and driver issues) for some possible solutions. 
 
For more information about using voice modems or telephony cards, please see: Telephony 
Hardware (TAPI and driver issues). 
 
 
Registration & Purchase Requirements 
 
If you want to use IVM after you have tested it, you must purchase a licence (register) for each 
installation of IVM. For more information, please see: Purchasing and Registering IVM. 
 
 



 

 

General Concepts 
 
Out-Going Messages (OGMs) 
 
Out-Going Messages ("OGMs") are central to the way IVM works. The call state at any time is 
centered around the current OGM. The information that attaches to the OGM ("OGM Properties") 
determines how the call proceeds. 
 
When IVM is used as a simple answering machine, only one OGM is needed. That OGM will be 
the message "Thank you for calling... please leave a message after the tone". The Properties of 
that OGM will be set with the active command "Leave Message for Mailbox... Default" at the 
message end. 
 
A more sophisticated interactive voice response setup might have hundreds of OGMs all chained 
together with menus and other active commands (an IVR Program see below). Each OGM could 
have different menus, messages and other properties. If you are creating a complex setup with 
many OGMs, you will find the "OGM List" to be the central point when setting up the system. 
From the OGM List you can also view the useful OGM Report which lists all the menus in logical 
order. 
 
OGMs must not be confused with Mailbox Personal Greetings. While they are both messages and 
can sometimes do the same thing, Mailbox Personal Greetings cannot have any interactivity 
attached to them and are linked directly to a single Mailbox. 
 
For more information about OGMs, please see: OGM Properties. 
 
Voice Mailboxes and In-Coming Messages 
 
When the caller leaves an In-Coming Message it is usually recorded into a Voice Mailbox. The 
Mailbox Properties determine how and where the message will be sent or accessed. Messages 
can be forwarded as attachments to an email, accessed using an Internet Browser (Web Access), 
uploaded to a FTP server, copied to a folder on the network, forwarded to a telephone number 
(outward dial) or accessed from a remote telephone by dialling in to IVM and entering an access 
code. Of course, the messages for any Mailbox can also be played directly using IVM. 
 
Usually, you would setup one Mailbox for every person in your office who would be receiving IVM 
messages. There should also always be the "Default" Mailbox which is used when no Mailbox is 
specified. 
 
A Mailbox can also have a personal greeting that will be played immediately before the message 
is recorded only if the active command is set to play the personal greeting. In a single Mailbox 
setup, you would not use this (the OGM would be the greeting), but with multiple Mailboxes you 
might want to use a personal greeting for each Mailbox. 
 
For more information about Mailboxes, please see: Mailbox Properties. 
 
IVR Programs 
 
An Interactive Voice Response Program (IVR Program) is the system of all the OGMs chained 
together. These can be saved as IVR files for backup or for distribution on CD-ROM, or by the 
Internet. 
 
It is not necessary to save your current IVR Program when you exit IVM. IVM will keep all 



 

 

changes you make automatically until you create a new IVR Program. 
 
For more information, please see: Loading or Saving IVR Program Files. 
 
Some example IVR Programs are available for download at www.nch.com.au/ivm/examples.html. 
The example IVR Programs can be a useful demonstration when setting up your IVR system but 
you will still need to read this manual so you can follow the example and modify it for your 
requirements. 



 

 

Basic Answering Mode Setup 
 
These are the instructions for setting up IVM to work as a answering machine (ie. single OGM 
and single Mailbox). Even if you are intending to create something much more elaborate, we 
suggest you first setup IVM in this simple way to test the modem or telephony card and to give 
you an introduction to the way IVM works. 
 
After running the IVM install file, you will find that there is already at least one default answering 
OGM and the default Mailbox. Some installations of IVM will come with multiple default OGMs 
with different languages and accents. Select the preferred OGM using the pull down list on the 
IVM Main Window. 
 
Testing Modem/Telephony Device 
 
If you already have a TAPI compliant voice modem or telephony card (with both TAPI and Wave 
drivers installed) you should be able to call your number and IVM will answer. If you call your 
number and IVM does not answer or does not play anything, please see: Telephony Hardware 
(TAPI and driver issues). 
 
Changing the Out-Going Message 
 
To change the Out-Going Message, select "Properties..." from the OGM menu. With the OGM 
Properties Dialog Box open, click on the "Change Message Audio" button and select either 
Record, Import wav/mp3 or Synthesize Speech. Click OK to close the OGM Properties Box and 
click Close to close the OGM List. 
 
Setting up Default Mailbox 
 
Open the Mailbox Properties Dialog Box by selecting "Properties..." on the Mailbox menu from the 
IVM Main Window. You will then be able to set your remote access code, email address (if you 
want to messages to be sent to you by email or SMS), web site details (if you want to access 
your messages on the Internet) or telephone forward number and select whether you want to 
turn call screening on. For more information, please see Mailbox Properties. 
 
Call Screening 
 
If you want to listen to the callers' messages while they are being recorded, you must tick the 
"Use Call Screening" option from Mailbox Properties. 
 
Remote Access 
 
To be able to check messages by dialling in to IVM, you must tick the "Enable Remote Access" 
option from Mailbox Properties and enter the access code to use. When you call IVM, press '*' 
and then enter the access code. For more information, see Remote Access by Telephone. 
 
That's it! You have now setup IVM as an answering machine. You can now move forward to add 
menu options to your OGM. 
 
Now, if you want to create a more advanced setup with menus and data entry, you should 
continue reading the following sections of this manual. Note that some example IVR Programs 
are available for download using the examples link at www.nch.com.au/ivm/index.html. The 
example IVR Programs can be a useful starting point in setting up your IVR system. You will still 
need to read this manual so you can follow the example and modify it for your requirements. 



 

 

Beyond a Simple Answering Machine (Introduction to IVR 
Systems) 
 
To create a more advanced interactive voice response (IVR) setup, you will need to use menus, 
data entry and active commands to chain multiple OGMs together as required. 
 
Your attempts can be facilitated by use of the Call Simulator and by frequent reference to the 
system logs (File -> View or Print Logs).  Take one small step at a time, test the change with the 
Call Simulator and refer to the logs after every change. If the IVM behaves one way on the Call 
Simulator and a different way on real calls then that is normally an indication of a modem 
compatibility issue. 
 
IVM uses an OGM-object oriented system for creating complex menu systems. A number of OGMs 
are linked together with the menus and active commands that are setup using the OGM 
Properties. When you are setting up your system, you will work from the Out-Going 
Messages List to create and manage OGMs. 
 
You do not need to know any programming languages or to write any scripts to create a system 
with menus and data entry. If you read the next few sections of this manual carefully, you should 
be able to setup your system as required. 
 
Some example IVR Programs are available for download using the Examples link at 
www.nch.com.au/ivm/index.html. The example IVR Programs can be a useful demonstration 
when setting up your IVR system but you will still need to read this manual so you can follow the 
example and modify it for your requirements. 
 
Tools that are very useful when creating complex systems are the Call Test Simulator (so you 
don't need to call every time you want to test things) and the Most Recent Call Logs (for 
seeing what the IVM is actually doing during a call if it is not doing what you think it should). 
 
If you do not have time to create your own IVM system and would like a consultant to create one 
for you, see www.nch.com.au/ivm/support.html  for more information. Our technical 
support staff will forward your request to those on our IVM consultants list for quotes 
for the setup of a system. 
 



 

 

Using Menu Options 
 
A menu option is an option that a caller can select by pressing a key on their telephone keypad. 
When they press the key, IVM executes an active command. For example, "To hear our 
opening hours, press 1...". 
 
To setup menu options, select the OGM Properties "Key Response" tab. You can open OGM 
Properties by selecting the "Properties" item from the OGM menu on the IVM Main Window. 
 
You must select "Menu (single key press)" to use a menu. 
 
For each telephone key that the caller could press ('0' to '9', '*' and '#'), select the active 
command that IVM should execute when the key is pressed. If you do not want to assign an 
option to a particular key, select either the "No Response" or "Invalid Option" active commands. 
For more information, please see Active Commands. 
 
NOTE: by convention the '*' key is usually used for Mailbox Access Control (on an answering 
OGM), otherwise it should be set to "Go to..." the previous OGM or to "Repeat OGM". The press 
'#' key is usually reserved for data entry or otherwise "No Response". Please also see ISO/IEC 
13714 (www.nch.com.au/ivm/iso13714.html) which is the international standard for interactive 
voice response systems. 
 
 



 

 

Data Entry 
 
IVM can accept multiple digit data from the caller. This is useful for passwords, order taking, 
customer surveys, credit card numbers and so on. Data entry will also need to be used if you 
want to offer the caller more than 10 Mailboxes. 
 
To accept data entry you must select the "Data Entry" option from the "Key Response" tab of 
OGM Properties. 
 
The number that the caller enters is stored with a variable name. Each number that the caller 
enters must be given a different name so that the information can be accessed later. 
 
The user normally completes the entry by pressing the '#' key or by reaching the maximum 
number of digits. In both cases IVM executes the Active Command for "press '#'" (so you must 
always have an active command for '# or End'). 
 
Before executing the active command, IVM can validate the variable using a number range or a 
list of valid (or invalid) numbers. If this test fails, IVM says "that is not a valid number" and 
replays the OGM. 
 
The variables can be used at any point later in the call in a number of ways. Generally, anywhere 
you are able to enter text in an active command (eg. OGM, Mailbox, Logfile, Transfer Number) 
you can include the variable by circumfixing the variable with two % characters. For example, if 
you prompt the caller to enter a number which you give the variable name "transferext", you can 
use "888%transferext%" as the transfer number (assuming 888 was a prefix you wanted). If the 
user entered 123, the transfer number used would be "888123". 
 
Similarly you could use the variable in the %name% form as part of an OGM name, Mailbox 
name, Play file name, Record file name and as a parameter to a plugin call. 
 
You can also create a special log file of the data the caller has entered. This is useful for surveys, 
order taking, credit card payments and so on. You can create the log file as a comma delimited 
fields which can be imported directly into a database. To setup a log file, use the "Add Entry to 
Special Log" option on the Advanced tab of OGM Properties. 
 
Variables can be "read" out to the caller. For more information, please see OGM Properties - 
Advanced. 
 
Variables can also be sent to and returned by IVM Plugins for more information, please see 
Using IVM Plugins. 
 
The variables %time%, %date%, %cid%, %callername%, %linenumber%, %linename%, 
%did%, %drn% and %callsequenceno% are set automatically by IVM. 
 
You can also set 'global' variables. By global we mean it applies to all lines (if set on one call it 
will apply to all). Set global variables using the Advanced tab of OGM Properties. You can also set 
them from other programs using the Command Line Arguments (see 
www.nch.com.au/ivm/sdk.html). 



 

 

Active Commands 
 
Active Commands are the commands that IVM can execute when the caller presses a key, at the 
end of an Out-Going Message or when a transfer fails. 
 
No Response 
 
If this command is selected IVM does nothing when the caller presses the key. This option can 
only be used in a menu. 
 
Invalid Option 
 
If this command is selected IVM says "that is not a valid option" then replays the OGM. This 
option can only be used in a menu. 
 
Leave Message for Mailbox... 
 
If this command is selected the caller can record a message for the selected Mailbox. 
 
You can select whether IVM should play the Mailbox personal greeting before recording the 
message. This depends on the context. Generally with menu options or transfer fail you would 
want the personal message whereas with end of OGM you would not. 
 
Example: "To leave a message for our technical support department, please press 6". Create a 
new Mailbox called "Support" which could be set to email the message to 
support@yourdomain.com. Select "Leave Message for Mail Box... Support" as the OGM Properties 
Key Response Menu press '6' option. 
 
The mailbox name can include data-entry variable names circumfixed with the % character (often 
used were the PBX sends the extension number as in-band DTMF). 
 
If the mailbox does not exist with that name it is created with all the mailbox settings copied 
from the mailbox named "Default". 
 
If you have the option 'Use mailbox special menu' ticked then while the caller is recording a 
message they can press the # key to have an opportunity to change their message. You can 
change the text to "..once you have finished recording press #". When they press # they will 
then be offered the menu option "1 to record again, 2 to to listen or 9 to end the call".  
 
If you have the option 'Use OGM menu for any other keys' ticked then all (other) menu key 
options are governed by the previous OGM menu properties. 
 
Go to OGM... 
 
If this command is selected IVM opens to another OGM. This command is essential for multiple 
OGM interactive voice response setup as it lets the caller hear a sub-menu by pressing a key or to 
sequence OGMs by selecting "Go to OGM..." as the active command for the End of the Message. 
 
Example: In your Answering OGM say "If you know the name of the person you want to speak to, 
please press 1. Otherwise, for s...". Create another OGM which says "For Joe Bloggs, press 1. For 
Jane Doe, press 2...". On the Key Response Menu of the first Answering OGM select "Go to 
OGM..." in the pull down list next to "Press '1'". 
 



 

 

The OGM name to go to can include data-entry variable names circumfixed with the % character. 
 
If you are using multiple level folders you can specify OGM names with folders. For example 
"MyMenus\StartOGM" would specify an OGM in the StartOGM folder. (You must have created the 
folder using the OGM Manager first). You can also specify relative directories like ".." for the 
parent folder or "." for the current folder (eg. "..\MyOtherFolder\StartOGM"). 
 
 
 
Play Wav/MP3 File... 
 
If this command is selected IVM will play the selected wav or mp3 file. When the playback is 
complete, the OGM Message will be replayed. IVM supports most wav files and mp3 (layer-3 only, 
not layers 1 or 2). 
 
Example: In your Out Going Message say "To hear our contact details or our office hours, please 
press 1". On the Key Response Menu of the OGM select "Play Wav/Mp3 File..." in the pull down 
list next to "Press '1'". When you select the option, you will be able to browse to select a wav file 
which could be a recording: "Our address is... Our Fax number is... Our email address is... Our 
office hours are... ". (You could do exactly the same thing by creating another OGM but the play 
option is sometimes simpler). 
 
NOTE: There are times when it might be preferable to create a new OGM with the audio file and 
use the "Go to OGM" command instead of the "Play" command because then the audio can have 
its own menu options. 
 
The play file name can include data-entry variable names circumfixed with the % character. 
 
Record Wav File... 
 
If this command is selected IVM will record the selected audio file. 
 
NOTE: To record simple messages you should consider creating a Mailbox and use the "Leave 
Message for Mailbox..." option. Mailboxes can be much simpler than manually recording files 
using the Record Wav file command. 
 
This option can be used to let the user record the audio for other OGMs. For example, if you have 
an sports results line, this feature can be used to let the reporter (after entering an access code) 
record the updated results. 
 
The record file name can include data-entry variable names circumfixed with the % character. To 
ensure that a different files is used for each call, use the variable %callsequenceno% as part of 
the record file name. The callsequencenumber is a unique number for each call. 
 
The maximum record time and silence detect time must also be specified. If the maximum time is 
reached or silence is detected, the "After autostop" command will be executed. The minimum 
silence detect time is 1 second (0:00:01.0) which can be useful when prompting the caller for a 
sequence of very short statements (eg. callers name). 
 
If you have problems with silence detection when recording, you may need to adjust the Record 
Detect Level from Settings. 
 
An advanced option is the "Append to end of previous recording" option. When this is ticked, the 
recording is joined to the file end. This can be useful when you want to prompt the caller for 



 

 

many items (eg. name, address etc.) but have the recording as a single file. 
 
Rewind/Fast-forward 
 
If this command is selected during playback (of the OGM or an external wav file), playback will 
skip forward or back a predetermined time. Negative values are rewind and positive are forward. 
Times are entered under in the format [-]h:mm:ss.s. For example rewind 5 seconds is -0:00:05.0. 
 
Pause / Resume Playback 
 
When this command is selected during playback, playback is paused until it is selected again. You 
also specify a maximum pause time (default 60s). After this time playback is resumed 
automatically. Do not select too long periods because if the caller hangs-up while in pause and if 
the end-of-call tone is not detected the line will be kept off-hook. 
 
Transfer to... 
 
For more information about these options, please see: Transferring Calls. 
 
Dial... 
 
When the Dial active command is executed, IVM dials the entered DTMF digits including hook-
flashes ('!') or pauses (','). When dialing is complete IVM executes the "Then" command selected 
using the Dial "Details". 
 
Access Mailbox Control 
 
If this command is selected the caller will then be asked to enter their access code to check 
mailbox messages. This command is usually selected as the press '*' option for the answering 
OGM. 
 
Repeat OGM 
 
If this command is selected the OGM is repeated. Any data entry is also cleared. 
 
Goodbye (Polite Hang-up) 
 
If this command is selected, IVM says "goodbye" then hangs-up. 
 
Hang-up (Immediately) 
 
If this command is selected, the call is hung-up immediately. 
 
 
 
 



 

 

Call Test Simulator 
 
If you are making an interactive voice response system, with a large number of OGMs, you can 
use the Call Test Simulator to save you having to call your phone many times during the testing 
process. 
 
To run the Call Test Simulator, select the "Call Test Simulator" item from the File menu, or click 
the <Simulator> button on the IVM tool bar. 
 
The Call Simulator works almost exactly the same as a  normal call. The call will always be 
treated as if the call was on line 1, the caller ID was 555-555-5555 with caller name "Simulator". 
 
You may notice some differences in audio quality and response times (the Call Simulator is faster) 
when compared to a real call. 
 
If you have problems attempting to record with the Call Simulator, you should check that you 
have a microphone plugged into the sound card of your computer and that the Sound Record 
Mixer has the microphone turned on. 



 

 

Using Voice over IP (VoIP) 
 
Voice over IP means that instead of connecting to a real phone line you connect though a 'virtual' 
phone line to a voice over IP server through your broadband connection. 
 
This technology means you can get a free number to receive and make free Internet phone calls 
(from and to Internet calls) and for a fee even have an ordinary phone number which is routed to 
your computer through the Internet. If you need a dedicated phone line for IVM you will find 
VoIP numbers usually are much cheaper than having a real line connected. And you don't need 
any telephony hardware. 
 
For outbound automated calls depending on the gateway you select you will find calls made via 
VoIP are dirt cheap compared to the cost of phone calls made on an ordinary phone line. 
 
IVM uses the most popular "SIP" protocol for VoIP calls. We fully support the standards 
RFC3261(SIP), RFC3515(REFER), RFC3891(Replaces) and RFC2833(DTMF). 
 
To sign up for a free Internet phone number or for recommended 'real number' gateways, please 
see www.nch.com.au/talk/sip.html. If this is your first time with VoIP we also recommend you 
download the free Express Talk VoIP Softphone from www.nch.com.au/talk/index.html, which 
is like a telephone in your computer. 
 
You need to have your server, username and password before you can setup IVM to accept or 
make calls via the Internet. 
 
Once you have signed up use the VoIP tab of Settings to add the lines. You can set multiple lines 
on the same number if required. 
 
For more advanced setups with transferring calls etc. you can also download the Axon Virtual 
VoIP PBX from www.nch.com.au/pbx/index.html. Axon is VoIP PBX software which works 
exactly like a business phone system.



 

 

Connecting to Telephone Key Systems or PBXs 
 
IVM is often installed in an environment where there is telephone system or PBX. Broadly the 
types of usage are for voice mail (recording messages for unattended phones), call attendant 
(playing a menu and directing calls accordingly) or other interactive voice response systems (eg. 
credit card payment or and information line). 
 
NOTE: Even though in some technical dictionaries they mean different things in this manual 
"PBX" is used for "telephone key system" or "PABX". We intend it just to mean a business 
telephone box. 
 
For professional setups you need to know you PBX well. If you don't know your PBX and what it 
can do, read the manual or call in the supplier. The information that follows is intended for more 
telephone-technical people. 
 
One requirement that applies in all circumstances is that the calls for IVM be directed to analog 
ports. IVM will almost always be running on a computer that has a professional telephony card 
(see the recommended telephony boards and voice modems list at 
www.nch.com.au/ivm/modems.html). These boards all have analog RJ12 style sockets. The first 
step is to ensure you have analog ports wired from your PBX. 
 
The next step is to program your PBX to direct the calls as required to those ports. 
 
Voice Mail 
 
In an office IVM needs to decide who the call was for (and which mailbox to use). In a very 
simple setup the IVM could play a menu and let the caller select. But normally the PBX can send 
the intended extension to IVM. 
 
Most PBXs can be programmed to send a DTMF dial string (inband signalling) when the IVM picks 
up the call. This string of digits is dialled within a short time after answering. You need to find the 
format of this string in the PBX manual. 
 
Once you know the format of the dial string: 
 
1 - On the Key Response tab of OGM Properties select "Data-Entry". 
2 - In the maximum digits field enter the number of digits the PBX will send. 
3 - Tick the "Allow # in data entry" field. 
4 - Tick the "Use special digits mapping function". 
5 - Click Settings button next to it. In the box next to "Advanced parsing dial string" enter the dial 
string in the form XXXX111XXX where 1 corresponds to the intended extension number digits and 
X are digits to be ignored. In the box to the left of 1 enter mailboxno (all one word, all lower 
case). 
6 - On the Message tab of OGM Properties next to "Then" select 'Leave Message for Mailbox' and 
type: MailBox%mailboxno% 
 
If your PBX redirects a call meant for extension 123 it will leave it in MailBox123. You can change 
the settings of the Default mailbox if required. 
 
On some PBXs you can also dial a string to turn off or on a message waiting light. To do this, use 
the "Mailbox Message Notification" options of MailBox properties. 
 
 



 

 

AutoAttendant - (Menu + Transfer) 
 
For auto-attendant and transferring calls the most important thing is that your PBX allows you to 
transfer calls with a 'hook flash' dial sequence. Check the manual and then see Transferring 
Calls for how to setup for call transfer. 
 
The biggest source of problem is hook flash time (there is no international standard and different 
PBXs use different times). If the IVM hardware takes too long the PBX thinks it has hung up. If it 
is too short nothing is transferred. Check the flash time in the PBX manual. And check the driver 
settings for your telephony card. They must match. 
 
Interactive Voice Response (IVR) Systems 
 
These are easy. Just program the PBX to send the calls to the ports and IVM will do everything 
from there. 
 
You might want to consider if you need to go through the PBX at all - it might be easier to 
connect to the external analog lines directly. However sometimes a PBX is an easy way to 
connect to public digital lines (PBX ports are much cheaper than dedicated T1 telephony boards). 
 
Call Recording 
 
We make dedicated software for call recording applications. See the VRS Recording System at 
www.nch.com.au/vrs/index.html. 
 
Telephone On Hold Messages and Music 
 
We make dedicated software for playing telephone on hold messages and music through a PBX. 
See the IMS On-Hold Player System at www.nch.com.au/ims/index.html. 
 
VoIP PBx 
 
With VoIP technology you don't need a PBX. Just download the Axon Virtual VoIP PBX from 
www.nch.com.au/pbx/index.html and install it on your server. You can plug any VoIP phone into 
your network and it will work as an extension. IVM can be set as extension(s) using the VoIP tab 
of Settings.



 

 

Remote Access by Telephone 
 
You can check your IVM messages in any Mailbox by dialing into IVM.  
 
To do so, your Mailbox must have the "Remote Access (check messages by telephone)" option 
ticked and the access code entered. You must also make sure the Answering OGM has "Access 
Mailbox Control" as the key response item for 'Press '*''. 
 
Note: The access code must be unique to each Mailbox. No two Mailboxes should have the same 
access code. 
 
To access your Mailbox, when the call is answered, press the '*' key then enter your access code 
followed by the '#' key. 
 
You will then be played any new messages. The options are: 

1.   Play the Message Again. 
2.   Keep the Message and Skip to Next. 
3.   Transfer to another mailbox (see below). 
5.   Delete Message. 
8.   Enter Mailbox Setup. 
9.   End the Call (Goodbye). 
*.   Another Mailbox. 
#.   Keep the Message and Skip to Next. 

 
If you press 8, you can enter Mailbox Setup to record your personal greeting. The Mailbox setup 
options are: 

1.   Play Personal Greeting. 
2.   Record Personal Greeting. 
5.   Stop (Play or Record). 
9.   End the Call (Goodbye). 
*.   Another Mailbox. 
#.   Stop. 

 
Note: If you want to be able to record personal greetings this way, you must be using the 
Mailbox personal greeting option as the active command details. In the case where you are using 
IVM as a simple answering machine, you must clear the audio of the default answering OGM 
(using OGM Properties) and select the "Use Personal Greeting" option of the "Then:" active 
command greeting. 
 
To transfer a message to another mailbox press 3 followed by the first few digits of the other 
mailbox’s access code and then #. IVM transfers the message to the first mailbox starting with 
the specified digits. For example if mailbox 10 has access code 101234 then pressing 3 10 # will 
transfer the current message to that mailbox. 
 
Tollsaver 
 
If the Tollsaver is enabled, IVM will wait at least 5 rings before answering if there are no 
unplayed in-coming messages. If there are in-coming messages it will answer at 3 rings. When 
using remote access you can use this feature so you will not pay for a call when there are no new 
messages if you hang-up by the fourth ring. 
 
The Tollsaver can be enabled from the General tab of the Settings Dialog Box.



 

 

Remote Access by Internet (Web Access) 
 
Please refer to the Settings ~ Web Access section of this manual for details. 
 
 
 



 

 

Transferring Calls 
 
If your telephone company or PBX offers the facility to transfer calls from a normal phone or 
extension, IVM will be able to transfer calls by dialling the appropriate sequences. The call 
transfer feature may be branded under trade names by your telephone company (eg. Telstra's 
"Business Links" service). If your telephone company does not offer an effective, you might be 
able to use a conference call feature to "simulate" call transfers with IVM (see below). 
 
In addition if you are using VoIP Lines IVM can transfer calls using VoIP. But please note that 
only Blind Transfer is supported for VoIP lines. Most of the comments below relate to normal 
lines. For VoIP lines it is really just a matter of selecting Transfer in the menu from OGM 
Properties. 
 
IVM cannot directly transfer between VoIP and conventional telephone lines. To do this there 
needs to be some form of VoIP to PSTN gateway, such as a FXO Adapter (for more information 
see  www.nch.com.au/hardware/fxo.html ) or a VoIP gateway provider (for more information see 
www.nch.com.au/talk/sip.html ). 
 
Before you can setup IVM to transfer calls you must understand exactly how to transfer a call 
using an ordinary telephone handset. It is important that you refer to the documentation of your 
PBX or of the transfer feature of your phone company. The most common system is to press the 
(hook) flash button to initiate the transfer ("!"), wait for the dial tone (",,,"), dial the number then 
either hang-up to complete the transfer or press flash again ("!") to retrieve the call. 
 
Overview (How IVM Transfers Calls) 
 
The only connection between IVM and the telephone system is a simple phone line. The only 
signals IVM can use to transfer calls is dialled digits, a hook-flash ('!') or pauses. 
 
To transfer calls, IVM follows the sequence (as entered using the Transfer tab of Settings) that a 
person would need to do using a regular phone. (A regular phone is not the same as phone 
system handsets that are specially wired to the phone system). 
 
Most problems arise when the sequence has not been properly entered (or understood) or where 
the voice modem or telephony device does not handle hook-flashes correctly (see below). Use 
the Most Recent Call Log for the line to check IVM is doing what you think it ought to do. 
 
NOTE: this discussion relates just to real call transfers. VoIP blind transfers are easy and 
automatic. 
 
Blind Transfer 
 
A blind transfer is a transfer where IVM simply hangs up after making the transfer without 
waiting to confirm that the transfer was accepted. Blind Transfer is currently the only 
method supported for VoIP lines. 
 
NOTE: You cannot use “simulate a blind transfer” with a conference call feature (see the 
discussion below). 
 
Confirmed Transfer 
 
With a confirmed transfer, the person to whom the call is transferred is given an option to accept 
or reject the call. If the call is rejected or is not answered, the call is brought back to IVM. If a 



 

 

call is brought back, IVM will execute the transfer fail active command. 
 
With a confirmed transfer you can set the number of times that the prompt is repeated before fail 
(the default is 7). You can use this to determine the time before fail. However, you must note 
that the number you enter is not seconds but the prompt repeat count. 
 
Answer Detect Transfer 
 
When this option is selected, IVM initiates the transfer and then waits for the call to be answered. 
If the call is answered it plays the answering party a short tone then completes the connection. If 
the call is not answered, the IVM rejects the transfer. 
 
For this to work well the answer detect settings must first be setup. This is done via the 
Outbound Autodial Calls window, which is accessed by clicking the <Outbound> button on the 
main IVM window. See Call Answer Detect Settings for details. 
 
Transfer Settings 
 
While the actual transfer number is part of the active command details, the digits to be dialled 
before and after the transfer number to initiate or complete the transfer must be setup using the 
Transfer tab of Settings. 
 
The (hook) flash is represented by the '!' character in dial strings. A pause is represented by a ','. 
We recommend that you always add a pause after a flash when you expect to dial further digits 
(ie. '!,') to give time for the dial tone to come on. 
 
Simulating a confirmed transfer with a conference call feature 
 
If your telephone company or PBX does not support call transfers but does support a conference 
call, IVM can use this feature to "simulate" a transfer. When you tick the "Simulate call transfers 
as a conference call", IVM will run through the normal steps to setup a conference call (thinking it 
is transferring the call) and then stay online for the call duration. (Note: Your phone line will be 
busy for the call duration). 
 
This option is usually only effective with confirmed transfers, not blind transfers. 
 
Transfer Problems 
 
If you have problems setting up a transfer with IVM, make sure you are able to transfer correctly 
using an ordinary telephone. 
 
IVM cannot directly transfer between VoIP and conventional telephone lines. To do this there 
needs to be some form of VoIP to PSTN gateway, such as a FXO Adapter (for more information 
see  www.nch.com.au/hardware/fxo.html  or a VoIP gateway provider (for more information see 
www.nch.com.au/talk/sip.html). 
 
The other possible problem with transfers that use a hook flash is that different countries and 
different phone systems can require different flash times. Check your PBX flash time or ask your 
telephone company (if you are not using a PBX). 
 
For professional telephony cards, you can usually set the flash time using the Configure Hardware 
Box. (Use Settings / Devices / Properties / Configure). 
 
For voice modems you can add the Extra Setting S29=X where “X” is the flash time in tenths of a 



 

 

second. Add the S29=1 setting to the "Extra Settings" for the modem (Settings / Devices / 
Properties / Configure / Connection / Advanced). 
 
Sometimes IVM dials too quickly for the PBX or your phone company. In that case you may need 
to insert a pause (',') or longer pauses (',,,') using commas after the flash character ('!') and after 
the dialled digits.



 

 

Log Files 
 
To open, print or delete logs, select the "View or Print Call Logs" item from the File menu. 
 
Call Logs 
 
IVM logs every call (including those calls that are not answered). The log includes the date, time, 
Caller ID (if supported by your hardware) and whether or not it was answered. 
 
Call Logs are listed by date. 
 
Most Recent Call Logs 
 
For every line, IVM makes a detailed log of the most recent call including call details, each OGM 
opened, any keys pressed by the caller or any commands pressed. 
 
These can be very useful for diagnostics on complex IVR systems. If there is a mistake in your 
setup, by viewing the log after a call on the Call Test Simulator, you can see where things are 
going wrong. 
 
The Most Recent Call Logs will be named "Most Recent Call Line X" and can be viewed or printed 
by selecting the the "View or Print Call Logs" item from the File menu. 
 
System Logs 
 
The IVM Answering Attendant Log daily system logs contain all information including the Call Log 
information, the Most Recent Call Log information any other system errors and messages. 
 
SIP Trace 
 
IVM will also record IVM Answering Attendant SIP Trace logs for VoIP lines if this has been 
enabled. See the Advanced tab of Settings - Telephony - Line Properties - VoIP Line.  
 
Special Logs 
 
IVM can also create special logs of calls that use a particular OGM including any data that the 
caller may have entered. These can be used to count the callers (and caller IDs) of callers that 
select a particular option, or to record the data the caller has entered. 
 
To create a Special Log, tick the "Add Entry to Special Log" option on the Advanced tab of OGM 
Properties. Enter the log name and the log line format. The log name is usually a name but can 
be a full file path. The log line format can include any data field variables (between two % 
characters). You can also use the call variables %time%, %date%, %cid%, %callername%, 
%linenumber%, %did%, %drn% and %linename%. If you are intending to import the log 
directly into a database or spreadsheet, we recommend you use commas to delimit each variable. 
(This is particularly useful when using IVM for customer surveys). 
 
Modem Logs (Voice Modems only) 
 
These are not strictly IVM logs (they are created by TAPI's Unimodem V driver). They are useful 
when you think there might be something wrong with your voice modem. To view the modem 
log, select your Modem Properties from the Windows Control Panel and click View Log (under 
Diagnostics in Windows 2000/XP).



 

 

Outbound Autodial Calls 
 
IVM can be used to make automated outbound calls. It automatically dials the number, waits for 
the caller to answer then starts with an OGM message and follows a normal call flow. 
 
Before IVM can make outbound calls at least one line (or VoIP line) must have "Allow outbound 
and message forward calls" ticked from Settings - Telephony. 
 
To setup for outbound calls, select the "Outbound Autodial Calls..." option from the File menu, or 
click the <Outbound> button on the main IVM window. 
 
List of telephone numbers to dial 
 
Enter the list of numbers to dial separated with semi-colons. The list will automatically empty as 
calls are made. If you might want to use the same set of numbers again in future, you can user 
the Save As button to save the list (as a .txt file). The normal copy (Ctrl+C) and paste (Ctrl+V) 
functions also work in the numbers list. 
 
OGMs to start with 
 
Select the OGM(s) that IVM starts with when the call is answered. 
 
You can select different OGMs to start with depending on whether the call is answered by a 
answering machine or by a real person:  
 

• OGM to start with if answered by a person  

The selected OGM will be used if IVM determines that the call has been answered be a 
person.  

• OGM to start with if answering machine  
The selected OGM will be used if IVM determines that the call has been answered by an 
answering machine.  

• OGM to start if call is not answered 

An optional OGM may be started if the call is unanswered. Select "None" if no OGM is to 
be started for unanswered calls. 
Note that this OGM will have limited functionality due to there not being any telephony 
line to interact with.  
The intention is therefore to allow actions such as writing to a special log or using a 
plugin to update a database record.  

 
Note: Detection is not accurate so your system must be tolerant of either. Detection works by 
using the length of the voice after the call is answered. A longer 'message' indicates an answering 
machine while a short 'greeting' indicates a real person. This can be adjusted using the Call 
Answer Detect Settings. 
 
Number of attempts for each called number 
 
IVM can be set to attempt to redial numbers that were not answered. It goes through the list 
once. At the end of the list, it repeats the list calling all numbers not answered. 
 
Minimum interval between reattempted calls 
 
If a call to a particular number fails IVM limits the time before which it will be attempted. Enter 
the time here in minutes. The default is 30 minutes. 



 

 

 
Make calls between times 
 
IVM can be set to only make calls between a fixed time of day (to stop calls late at night for 
example). Enter the start and end times. To allow calls 24 hours a day enter 00:00:00 to 
24:00:00. 
 
Advanced Options 
 
Advanced users can append data to each number if required. For example if the number was 
5551234567&ogm=My+OGM&data=999 the call would answer using the OGM named "My OGM" 
and with the variable "data" set to "999". You can also set ogmanswer to specify a different OGM 
for answering machines. 
 
For example:    5551234567&ogmanswer=OPerson&ogmmachine=OMachine 
 
You can specify alternate numbers separating each with a \ character. If the first number fails, 
when the call is reattempted IVM will use the next number. For example 
5551111111\5552222222\5553333333 will try those 3 numbers in turn. 
 
If you need IVM to just dial a some DTMF digits after answering and then disconnect again use 
the argument dialanddrop. For example, 5551234567&dialanddrop=890 will dial the number 
5551234567, wait for it to answer, dial the DTMF digits 890 then hangup. The comma "," can be 
used to insert pauses. 
 
� &ogmOGM to use for this number  

 
� &ogmanswerOGM to use if this call is answered by a person  

 
� &ogmmachineOGM to use if this call is answered by an answering machine  

 
� &dialanddropdial these digits after the call is answered  

 
If you need one call to initiate other outbound calls, download and install the plugin OUTBOUND 
from www.nch.com.au/ivm/plugins.html 
 
Other software can also initiate outbound calls (or add them to the list). See the IVM SDK 
(software development kit) at www.nch.com.au/ivm/sdk.html  about how to link your program to 
IVM . 
 
 
General Tips for using Outbound Calls 
 
Answer detection is never accurate because a computer cannot easily tell the difference between 
voice and some tones. When you design an outbound autodial system, you should make it 
tolerant of calls that are detected as being answered too early. For example, the initial OGM 
should be repeating and should ask the caller to acknowledge the call by pressing a key. 
 



 

 

Call Answer Detect Settings 
 
Before IVM will correctly detect when calls are answered you must set the "Call Answer Detect 
Settings". Click on the <Settings> button at the bottom of the Outbound Autodial Calls window to 
open these. 
 
Use software based answer detection 
 
Voice modems are unable to detect when a call has been answered. IVM includes a software 
detection system to attempt to accurately detect when a call has been answered. 
 
Note that because IVM will never be able to “understand” what is really happening, it can never 
be sure that the person who has answered the call has finished their sentence. It must wait for 
silence (usually about 2 seconds). This means there will always be a short delay after the person 
answers. Also note that IVM may miss-detect and answer due to messages on the line. 
 
In all circumstances you should design your outbound menu structure to be tolerant of early 
detections, false detections and late detections. 
 

Ringing silence detect time [ms] 
 
When IVM detects a ring tone it will wait longer before starting than after voice. This 
time must always be a little longer than the maximum time between ring tones in your 
country. In the USA / Canada use 4100ms (the maximum time is 4000). In Europe and 
Australia you can reduce this to 3100. 
 
Voice silence detect time [1000 - 4000ms] 
 
After voice is detected IVM waits for a silence gap before it begins. If this is too short 
IVM can begin between words. A reasonable time is usually 2000ms. Be careful if you 
expect many answering machines because answering machine message often have 
longer gaps. 
 
Ringing or busy time out [10 - 15 secs] 
 
IVM will abort the call as being unanswered if it detects ringing or busy tone for longer 
than a predetermined time. A reasonable value is 15 seconds. 
 
Answer detect fail time out [15 - 60 secs] 
 
IVM will abort all calls as being unanswered (including those with voice detected) after a 
maximum time without any silence detected. 30 seconds is a reasonable. 
 
Assume answer machine if voice longer than [secs] 
 
If you want to play different messages to calls answered by answering machines, IVM 
can attempt to guess whether the voice is a real person or an answering machine based 
on the length of the greeting. A typical value might be 8 seconds. If it is longer than this 
an answering machine must be assumed. 
 
If you expect many answering machines you should use a longer voice silence detect 
time because answering messages can often have longer gaps. 
 



 

 

Note that answering machine detection is never 100% accurate. You should design you 
menu structure to be tolerate of misdetections. 
 

Hardware supports answer detection (assume answered) 
 
Use this option when using professional telephony hardware. The hardware is able to detect 
when a call has been answered as well as when that caller hangs up. 
 
 
 
 



 

 

Fax Support 
 
Sending Faxes - Fax-Back Systems 
 
IVM can work as part of a fax back system to receive the caller's fax number and other 
information (eg. document number) and then fax a document (a tif file) to the specified number. 
Similarly IVM can also use the fax plugin to fax call logs, information to you at a remote location. 
 
To do this you must download the fax plugin following the "plugins" link at 
www.nch.com.au/ivm/index.html. The plugin uses Microsoft Fax which is supplied with Windows 
2000/XP. 
 
To setup a faxback system, you will need to be confident with using IVM Data Entry and 
Plugins. 
 
Receiving Faxes 
 
When IVM detects an incoming fax, it can do one of two things... 
 
TAPI Fax Mode Handoff 
 
If your fax software is TAPI based, IVM follows the correct TAPI prescribed call hand-off 
procedure so the call can be accepted by other fax software. 
 
Unfortunately, as at the date of release of this software version Microsoft does not yet support 
this feature. 
 
Dial this number 
 
If you run a fax machine on the same line, IVM can trigger your fax machine to turn on when 
IVM detects a fax tone. After your fax machine is turned on IVM hangs up. 
 
IVM turns on your fax machine using a dial sequence that it dials the moment it detects a fax 
tone. Refer to your fax machine manual. You will find that you can usually turn on the fax feature 
if you hear fax tones on the line by dialling digits. Go to Settings -> Telephony and from the 
Options tab of Line Properties for any of your standard hardware (ie. non-VoIP) telephone lines 
select the "Dial this number" option and enter the digits that are required by your fax machine. 



 

 

Distinctive Ring Detection 
 
On some phone lines it is possible to have different ring 'sounds' to differentiate between calls of 
different type (eg. faxes or voice calls) or calls to different numbers (where different numbers are 
received on one line). IVM can use this to only answer particular calls or to play different 
messages to different callers. 
 
Distinctive Ring is processed using a Distinctive Ring Number. The number is somewhat arbitrary 
(see below). It is used under "Use Number ID Validity Checking" on the Date-Time ID tab of OGM 
Properties to either move to a different OGM or to not allow (or answer). 
 
Distinctive Ring Settings 
 
The Distinctive Ring Settings are on the Line Properties from the Telephony tab of Settings (see 
Settings ~ Telephony ~ Line Properties). 
 
Use hardware based distinctive ring 
 
When selected the DRN is a number returned directly from the voice modem or telephony voice 
board. If the hardware supports distinctive ring detection we recommend that you use it. The 
problem is that many voice modems and telephony voice boards do not support distinctive ring 
and in that case you need to use software detection. 
 
Use maximum ring interval - software based ring detection 
 
When this option is selected, IVM uses the maximum time between rings to calculate the DRN. If 
the maximum time is above the set time it will report a DRN of 1. If it is below it will report a 
DRN of 0. 
 
Setup DRN 
 
The DRN (and the maximum time between rings) for any answered call is recorded on the Most 
Recent Call log. Before you setup call the line with one ring first, let it answer and then look at 
the Most Recent Call log. Record the DRN and time (ms). Then call the same line with a different 
ring type again letting it answer and then comparing the DRN and time on the Most Recent Call 
Log. 
 
If the DRN number is different you can probably continue to use hardware based distinctive ring. 
Simply change the settings on the answering OGM (OGM Properties -> Data-Time/ID -> Use 
Number Validity Checking -> Distinctive Ring). 
 
If the DRN reported for the different calls is the same then your hardware probably does not 
support distinctive ring. In that case you must use software based distinctive ring detection. 
Compare the DRN ms times of the two calls. Select the "Use maximum ring interval" option (see 
above) and enter a time (in ms) that is exactly between the time reported by the different calls. 
When you next make calls, you will see the different DRNs on the Most Recent Call Log. 



 

 

Using IVM Plugins 
 
An IVM Plugin is an external program that IVM can run to process or obtain data. For example, if 
you are making a interactive voice response system to tell the caller the current temperature, a 
plugin can be used to read from the hardware and return the temperature to IVM. A plugin could 
also be used to restart the computer, access a database, process credit card orders and more. 
 
A number of useful plugins can be downloaded from www.nch.com.au/ivm/plugins.html. 
 
For more information about writing plugins (for programmers), please see the IVM Software 
Development Kit at www.nch.com.au/ivm/sdk.html. 
 
Using a Plugin 
 
A plugin is usually obtained as an exe file (or an exe file in a zip file).  
 
[1] Extract the exe file and save it in the IVM base folder C:\Program Files\NCH Swift 
Sound\IVM. 
 
From the Advanced tab of OGM Properties,  
[2] tick the "Run Exe or Run IVM Plugin" option and then  
[3] click "Open Run Exe or Plugin Settings". 
 
From the Run Exe and Plugin Settings dialog box  
[4] tick the "Is IVM Plugin Process" option, then  
[5] click on the "Add New Exe" button. 
 
In the Run Exe dialog box,  
[6] type the exe name including the .exe extension (eg "yourplugin.exe").  
[7] Enter the arguments that are sent to the plugin.  
 
The plugin writer will prescribe the arguments that must be passed to the plugin (check for a text 
file in the zip file distribution). Take care to get the order exact. You can include any variable as 
an argument by circumfixing it with %. Variables can include the system variables %time%, 
%date%, %cid%, %callername%, %linenumber%, %linename%, %did%, %drn% and 
%callsequenceno%. 
 
Information from the plugin is returned as one or more variables which you can use at any stage 
later in the call. Often one of these can determine which OGM to play next using the return 
variable name (circumfixed with % characters) as part of the OGM name to go to at the end of 
the current OGM. If it is a number, it can also be "Read" using the read number feature. 
 
Multiple plugins can be run in sequence by adding them to the list in the Run Exe and Plugin 
Settings dialog box. Arguments returned in variables from one plugin can be passed to the next 
using %variablename% as the argument(s). 
 
If you have difficulties using the plugin see the Most Recent Call Log for the line to view the exact 
data sent and returned from the plugin. 
 
Running other Programs or Files 
 
IVM can also run any other exe file (which in turn can be used to open almost all file types). 
However, if it is not a plugin, IVM will not be able to retrieve data from the process. To run or 



 

 

open a file that is not a plugin, untick the "Is IVM Plugin Process" option. 
 
If the file is not a true IVM Plugin the "Is IVM Plugin Process" option must NOT be ticked. 
 
Running a Plugin on Call Disconnect 
 
Sometimes you need to set your call so that if the call disconnects for any reason at any time 
later another plugin will be run. For example, this can be used to time call duration or to cleanup 
data relating to the call. To do this you set the variable "RunExeDisconnect". 
 
For example if somewhere early during your call your run a plugin "startcalltimer.exe", that plugin 
can return a variable "RunExeDisconnect=[path].exe%20%-stop". Then whenever the call 
disconnects however it disconnects IVM will run that plugin. 
 



 

 

Loading or Saving IVR Program Files 
 
An Interactive Voice Response Program (IVR Program) is the system of all the OGMs with all the 
program information (ie. properties). This can be saved as an IVR file for backup or for 
distribution on CD-ROM, or by the Internet. 
 
Loading an IVR Program File 
 
To load an IVR Program file, select Load / IVR Program from the File menu and then browse to 
locate the file. 
 
Note: Because update files can be saved in cumulative format (see below), you must take care 
not to accidentally load an early file. Cumulative update files must always be loaded in the order 
they are received. 
 
Loading using a Direct Remote Download 
 
IVM can download files directly from a remote server. You can then set IVM to automatically 
check the server for updates at the predetermined interval. This is ideal if the person who sets-up 
and maintains the IVR Program is remote from where the IVM runs. 
 
If you have been given a remote server (eg. ftp.nch.com.au) by the provider of your IVR service, 
select Load / Direct Remote Download, tick "Download using the Internet" and enter then server 
name. You should also tick "Automatic Regular Update Check". 
 
For more information about setting up and operation of a remote server, see Setup of a 
Remote Server System. 
 
 
Saving an IVR Program Files 
 
To save an IVR Program file, select the Save IVR Program File item from the File menu. 
 
Cumulative Update Files. Because audio files can be large, IVM lets you select what you want to 
save in the IVR Program. If you are using IVR Program files to distribute updates to a remote 
IVM, you can use this to send only the items that you have changed. When the remote IVM loads 
the file, it automatically collates the new material with the old. 
 
If you simply want to backup the complete IVR Program, just accept the defaults and click Save. 
 
If you want to save only a cumulative update file, select the modified OGMs (by holding down the 
control key) and then click Save. 
 
Save OGMs 
 
This is the list of OGMs that you want to include in the IVR file. Use the shift or control keys to 
select multiple files. 
 
Save OGMs - Remote Auto-Delete 
 
If this box is ticked, any OGMs which do not exist in the local IVM will be deleted on the remote 
IVM. 
 



 

 

Save Mailbox Settings 
 
To include mailbox properties, select the mailboxes in the Save Mailboxes list. 
 
You can also tick the remote auto-delete box to delete any mailboxes on the remote IVM that do 
not exist on the local IVM. 
 
By default, IVM only saves the mailbox properties and not the mailbox personal greetings. To 
save the mailbox greetings, tick the "Include Greeting(s)" box. 
 
Advanced  
 
Use the <Advanced> button for additional options related to saving IVRs. 
 
Advanced - System Prompts 
 
If you have changed any of the IVM System Prompts, you can include those files in the IVR file by 
selecting them in the System Prompts list. 
 
Advanced - Settings 
 
You can change any of the remote IVM settings by including the settings in the IVR file. The 
settings are not documented in this manual. We suggest you open the settings.ini file in the 
Program Files\NCH Swift Sound\IVM folder with notepad to view the possible settings. 
 
Advanced - Save Plugin(s) 
 
If you use plugins, they can be saved in the IVR. Select the exe files to be include using this list. 
 
Set Audio Compression Format to Reduce File Size 
 
Audio recordings can be large which can make the IVR file large. If you want to reduce the file 
size you can use an audio compression codec. 
 
Click on the "Set Audio Compression Format to Reduce File Size" button and select the format. 
The recommended format is GSM6.10. For others see our codecs information page at 
www.nch.com.au/acm/index.html. You should only use formats with 8000 sample rate. 
 
Advanced - Notes 
 
The IVR Program Notes are notes about the IVR Program. You can edit the IVR Program Notes 
by selecting the Notes item on the File menu. 
 
Tick the "Save IVR Program Notes" box to include the notes in the IVR file. 
 
If you tick the "Popup IVR Notes when Loaded" box, the Notes will open when the file is loaded. 
This is useful where you want to encourage the remote user to read instructions. 



 

 

Remote Server Setup 
 
IVM can operate remotely. At regular intervals IVM can check a server for any updates and, if the 
file has been changed, automatically load the updates. The updates can include changes to the 
OGMs, Mailboxes, System Prompts or Settings. 
 
This can be used in a single IVM system (for example where you want to setup and test the IVM 
program in your office but where the active IVM runs on a computer in the Telephone Room in 
the basement). 
 
It can also be used by voice prompt studios and telephone system consultants who offer system 
updates for any number of remote customers. A single Internet server setup can serve an almost 
unlimited number of remote systems. 
 
To setup a remote update server system, you must have a good understanding of computers, 
networks and the Internet (including FTP client software like WS_FTP). 
 
Basics 
 
All updates are with IVR Program Files. For more information about saving IVR Program Files see 
Loading or Saving IVR Program Files. 
 
File Names. To reduce the chance of errors (or the wrong file being loaded), the file the remote 
IVM loads has an implicit name based on the registration ID of the remote IVM. If you are testing 
IVM and have not yet registered, this is 0. The file name is ivmX.ivr where 'X' is the ID number. 
For example, if your registration ID for the remote IVM is 1078, the file name will be ivm1078.ivr. 
THIS IS CASE SENSITIVE. 
 
On the remote IVM, setup is straightforward. Simply point the IVM to the server using the Load / 
Direct Remote Download item from the File menu, tick the Automatic box and enter the interval. 
 
Internet FTP Servers 
 
To use this feature, you must have access to an FTP server that offers anonymous FTP access. 
You do not need to setup your own server. Most web hosting services include FTP. If you have a 
web site, there is a good chance you will already have access to an FTP server. 
 
To upload files, you must have a FTP client. For example, WS_FTP or CuteFTP. If you have your 
own web site, you probably already use one of these to upload your pages. 
 
Before you proceed, you must know the exact folder into which you must load files so that they 
can be downloaded directly from the root directory of the anonymous ftp account. This is often 
something like /home/youraccount/www/anonftp on UNIX / LINUX web hosting servers. As a 
test, you must be able to download the file (say for ivm0.ivr) directly by typing 
ftp.yourdomain.com/ivm0.ivr into Internet Explorer. 
 
The steps to update your remote IVM are: 
 
1.   Save the IVR Program File. The file name must be ivmX.ivr where X is the remote IVM's 

registration ID (case sensitive). For unregistered remote IVMs use the file name ivm0.ivr. 
 
2.   Upload the file using CuteFTP or WS_FTP into the root directory of the anonftp folder. 
 



 

 

3.   From the remote IVM, point it to your server using the Load / Direct Remote Download item 
of the File menu. For example, enter the server ftp.yourdomain.com. Also set the Automatic 
Interval. The recommended intervals are either 60 minutes (hourly) for fixed Internet 
connections or 1440 minutes (daily) for dial up connections. 

 
Local Area Networks 
 
If the remote IVM is running in the same building, you can use the LAN to update the IVM. This is 
usually faster than using the Internet. 
 
Create a shared folder on the network server. Save the IVR Program File with the correct file 
name (see above) into that folder. Then point the remote IVM to the folder using the Download 
Remote Direct option. The recommended time for the Automatic Check Interval is 2 - 3 minutes. 



 

 

Telephony Hardware (TAPI and driver issues) 
 
IVM uses the TAPI (Telephony Application Interface) standard to connect to a wide range of 
telephony hardware devices (including voice modems or professional telephony voice cards). 
Often when IVM does not work, it is because the hardware is not TAPI compliant or because 
there is some problem with the drivers or driver installation. 
 
If the drivers are not working properly: 
-           There will be no device listed in the add device pull down list; or, 
-           IVM will not be able to detect and answer in-coming calls; or, 
-           IVM will not be able to play the out-going messages; or, 
-           IVM will not be able to record messages. 
 
Customers frequently report that their modems are nearly working. Perhaps some key responses 
are not working, the audio quality is poor or there is an excessive delay in reaction time.  These 
problems are related to modem performance and not to any setting in the IVM software. The 
wave drivers associated with the modem turn the modem into a "pseudo sound card" for the 
production and recording of sound and for the detection of DTMF tones. The IVM requires that 
information collected by the modem ( DTMF responses and CID information ) be supplied to the 
IVM via TAPI.  Some modems will for instance supply their own software with CID information 
but will not supply the information via TAPI. They are not 100% TAPI compliant and are not 
completely compatible with the IVM. 
 
Please refer to the notes below on Voice Modems and Professional Telephony Cards for some 
solutions if your device is not working. 
 
For up-to-date information, please view www.nch.com.au/ivm/modems.html. 
 
You must be aware that we are unable to provide technical support for these problems. You 
should refer the problem to the manufacturer of your telephony card or modem. If you are a 
technical person, it can be useful to view the modem logs to see where the problem occurs. 
 
Voice Modems 
 
Voice Modems must be VOICE modems 
 
You must check that your modem is actually a voice modem. Refer to the modem documentation 
and specifications. Modems which are not voice modems cannot work with IVM. 
 
Voice Modems under Windows - Problems with W95A and WNT4 
 
Windows 95B/98/Me/2000/XP: These versions of Windows have the Microsoft Unimodem V 
drivers which work with many (but not all) voice modems. Because modem models change so 
frequently, we cannot provide a list of all the models that do work, we can only recommend that 
you simply "try it and see". If you have problems, you should also refer to the modem 
manufacturer. Some have fixes or upgrade drivers which are TAPI compliant. 
 
Windows 95A: Windows 95A was not shipped with the Unimodem V drivers. However, they can 
be downloaded from the Microsoft site at 
www.microsoft.com/windows/software/drivers/unimodem.htm. Microsoft may have moved the 
driver again by the time you read this. If so, simply search www.microsoft.com for Unimodem 
Download. 
 



 

 

Windows NT4: Windows NT4 does not support voice modems. You will need to use a professional 
telephony card or upgrade to Windows 2000/XP. 
 
Voice Modem Driver Installation - Remove unneeded/old modem drivers 
 
If you have upgraded your modem or installed additional modems without removing the 
unneeded drivers, Windows TAPI drivers might fail. If that is the case, the only solution is to 
uninstall all modems, and then reinstall your single modem. 
 
Voice Modem Driver Updates 
 
Some modems are distributed with the drivers supplied on the CD-ROM being only for the non-
voice modem version or are otherwise defective. Some manufacturers have fixed this problem 
with updated drivers that you can download from their websites. If your modem is not working 
with IVM, check your modem manufacturer's website for an updated modem and wave driver. 
 
There are update drivers for Zoom Voice Modems, USR (US Robotics) modems, Maestro Modems 
and many more. Visit the manufacturer's website to download the updated driver. 
 
Voice Modem Plug & Play Problems 
 
Sometimes when a modem is first installed, plug & play detects and installs the drivers for the 
non-voice modem equivalent. The solution to this is to uninstall your modem (you must to this), 
restart your computer then when plug and play detects your modem again, manually select the 
modem (instead of using the automatic driver selection feature of plug and play). 
 
Professional Telephony Cards 
 
Professional telephony cards tend to have much better audio quality and, once they have been 
correctly installed, work very reliably. 
 
More information about Professional Telephony Cards that are suitable for use with IVM is 
available at www.nch.com.au/hardware/telephony.html. CAHTA and CallURL telephony cards can 
be purchased directly via links on this web page.  
 
Dialogic Cards 
 
Dialogic have announced that from 1 January 2006 their telephony cards do not support TAPI. 
We therefore can no longer recommend their cards for use with our software.  
 
Music Telecom Cards 
 
Music Telecom cards are no longer recommended because they are defective. 
 
If you find other professional telephony devices that work well with IVM, please let us know. 



 

 

How To Guide 
 
Note that these are just short-hand tips. For more information, please refer to the other reference 
pages of this manual. 
 
How to (Re)Record the Out-Going Message 
Select the "Properties" item from the OGM menu. When the OGM Properties box is displayed click 
on the "Change Message Audio" button and select "Record...". 
 
How to Check Messages by Telephone 
See the manual page Remote Access by Telephone. 
 
How to (Re)Record the Greeting by Telephone 
On a single mailbox system, (1) clear the OGM message (select "Clear Audio" from the "Change 
Message Audio" menu of OGM Properties), (2) tick the "Leave Message for Mailbox" details "Play 
Mailbox Personal Greeting" option and (3) to Record a Personal Greeting for the Mailbox (Mailbox 
/ Properties / Change Greeting / Record). 
 
How to Make it Louder/Softer on the Telephone 
From the General tab of Settings, change the Volume Level Adjust setting. (Note the actual 
change is limited by your telephony device). 
 
How to Make it Louder/Softer through the Speakers 
From the Recording tab of Settings, change the volume setting in the Play Device and Volume 
box. 
 
How to Handle more than 10 Mailboxes 
When you create your Mailboxes, give them sequential number (eg. Mailbox 20, Mailbox 21...). 
Use Data Entry to let the caller enter the mailbox number with a named variable (say 
"mailboxno"). As the details of the "Leave Message for Mailbox" Active Command enter the 
Mailbox name as "Mailbox %mailboxno%". 
 
How to Pick-up Call using Same Line (pseudo-transfer) 
(1) Create an OGM (the "Hold OGM") with an message of say "please hold the line" then say 3 
minutes of "hold" music". (2) Under the Key Response tab of the Hold OGM's Properties have: 
Press '#' - Hang-up (immediate). (3) Under the Advanced tab of the Hold OGM's Properties, tick 
the "announce call through speakers" option and browse to find a suitable wav file (ideally this 
could say... "Call for ..."). (4) Under the Key Response tab of the Main OGM's Properties have 
Press 1 - "Go to OGM... Hold OGM". When a caller presses 1, you will hear the account file (eg. 
Call for Jay") through your speakers while the caller hears hold music. To 'take' the call simply 
pickup the phone and press #. 
 
How to send an SMS message when a message is received 
You need to use an email->SMS gateway. See www.nch.com.au/kb/10003.html for detailed 
instructions. 
 
How to 'ban' calls from certain caller IDs 
Using the menu open OGM -> Properties. From the Date-Time/ID tab tick "Use Number ID 
Validity Checking" and select "If CID is XXX don't allow" where XXX is the number. This will mean 
IVM will not answer those calls. Alternatively you can force IVM to take messages only for 
particular numbers by doing the reverse "If CID is not XXX don't allow". 
 
 



 

 

 
How to talk to a caller while the IVM is kept active 
You might have a situation in which you want to discuss a point with the caller and then want to 
return the caller to the IVM.  Create a "silent OGM" .  This is an OGM with no message but which 
waits for a certain extended length of time and perhaps repeats many times.  In the key 
response menu of this OGM you create a suitable escape - eg "# - goto 'OGM get details'".  As 
soon as the right moment arises you can press # on the local phone and the caller will be sent to 
the next appropriate OGM. You could even design several different paths depending on the 
caller's response. 
 
How to place a caller "on-hold" 
In the previous example you might want to place the caller "on-hold".  You could have a response 
such as "* - goto 'OGM on-hold' " . The on-hold OGM will play a suitable .wav file ( and repeat it 
if necessary). There would be an escape response in this OGM - eg to return to the previous OGM 
or to be transferred. 
 



 

 

Troubleshooting Problems 
 
IVM does not answer calls 
 
1.   Is IVM in [ON] Mode? Click on the [ON] button on the top right of the IVM Main Window so 

that it displays red. 
2.   Is your voice modem or telephony device listed in the line devices list on the Telephony tab in 

Settings? If you are unable to add the device, please see Telephony Hardware (TAPI and 
driver issues). 

3.   Turn Autohours off in Settings. 
4.   Check your OGM using OGM Properties. Can you play the message? Turn off all Date and CID 

Validity Checking and untick the Play External Wav File option. 
5.   Is some other software using the modem or telephony line device? Are you currently 

connected to the Internet using that line? 
6.   If you are attempting to use a modem, is it a true voice modem? 
 
If none of the above solves your problem, please see Telephony Hardware (TAPI and driver 
issues) for some hardware related tips. 
 
IVM answers the call but does not play a message 
 
1.   If you are attempting to use a modem, is your modem a true voice modem? 
2.   If you are attempting to use a Dialogic Telephony Card, have you installed the Wave drivers 

(in addition to the TAPI drivers)? 
3.   Check the OGM, using OGM Properties. 
 
If none of the above solves your problem, please see Telephony Hardware (TAPI and driver 
issues). 
 
No Line Devices appear when you Add a line device in Settings 
 
If you do not see a device, your TAPI drivers have either not been installed or have failed. For 
more information, please see: Telephony Hardware (TAPI and driver issues). 
 
Call hangs-up mid message or during recording 
 
This can happen when the hardware is miss-detecting the end-of-call tone during playback or 
recording. If it happens during playback, turn off the "Enable end-of-tone detection during 
playback" option on the Line tab of Line Properties for the line. This is accessed from the 
Telephony tab of IVM’s Settings. If it only happens during recording, turn on the "Enable end-of-
tone detection during playback" option but turn off the "Enable software based end-of-call 
detection" option. 
 
Recording does not stop when the caller hangs-up 
 
If you have end-of-call tones on your line check you have turned on the "Enable end-of-tone 
detection during playback" option using the Line tab of the Line Properties, accessed from the 
Telephony tab of Settings. 
 
If your line has silence at the end of calls increase the Record Detect Level a little. 
 
 
 



 

 

The audio quality is poor 
 
The audio quality is determined by the modem. Some voice modems offer only very poor quality 
voice. 
 
If audio quality is important, you should consider purchasing a professional telephony card. See 
Telephony Hardware (TAPI and driver issues) for suitable cards. 
 
IVM includes a playback gain device, playback tone control and playback dynamic range 
compressor which can be used to improve audio quality. For more information, please see 
Settings - General. 
 
Playback is too soft 
 
You can adjust the playback volume using Settings - General.  
 
Call transfer fails 
 
If you have problems setting up a transfer with IVM, make sure you are able to transfer correctly 
using an ordinary telephone. 
 
The other possible problem with transfers that use a hook flash is that different countries and 
different phone systems can require different flash times. Check your PBX flash time or ask your 
telephone company (if you are not using a PBX). 
 
For professional telephony cards, you can usually set the flash time using Phone and Modem 
Options from Windows Control Panel. For voice modems you can add the Extra Setting S29=X 
where “X” is the flash time in tenths of a second. Add the S29=X setting to the "Extra Settings" 
for the modem (Phone and Modem Options / Modems / [select modem] / Properties / Advanced). 
 
Sometimes IVM dials too quickly for the PBX; in that case you may need to insert a pause (',') or 
(',,,') using commas after the flash character ('!') and after the dialled digits. 
 
Caller ID is not displayed or displays "Unknown" 
 
1. Your voice modems might not support caller ID (not all do). Check your modem manual. 
2. You need to set IVM to answer after at least 2 rings. 
3. Your phone system may not have caller ID (sometimes you need to pay for the feature). 
4. If you are using a PBX extension, your PBX might not support caller ID. 
 
Email forward of messages fails 
 
If you have email problems when using MAPI: 
 
1.   Do you have MAPI compliant email software installed? Eudora, Netscape Mail, Lotus Notes 

and Outlook(*) are MAPI compliant. If you do not have MAPI software installed, simply 
download and install the free version of Eudora from tucows.com. 

 
2.   Have you setup your email software as the default MAPI server? In Eudora use Tools / 

Advanced / MAPI / Always. In Outlook use Tools / Options / Make Default. 
 
3.   Are you running as a service under Windows NT/2000/XP? If so, you must change the "Log 

On As" password for the IVM Service to be able to send email. To do this, after you have set 
Run as Service, open Control Panel / Administrative Tools / Services. Double click on "IVM 



 

 

Service", select the Log On tab, select this account and then enter the name and password of 
the user account IVM must use to send email. 

 
4.   *Outlook Problems: Some versions of Outlook cause problems because the automated send 

feature is disabled or it prompts you every time it needs to send a message (which defeats 
the purpose of automated email!). The easiest solution to this problem is to simply download 
the free version of Eudora from tucows.com. You will still be able to use Outlook as your 
main email application but you can setup Eudora simply for sending automated mail.  

 
If you have any of the above problems you should consider using the IVM Internal Simple SMTP. 
To do this, click on the Email Settings button next to email on the Mailbox Properties box. Select 
Internal Simple SMTP and enter your ISP's mailhost server and your email address. 
 
If you have email problems when using Internal Simple SMTP: 
 
1.   Have you entered your ISP SMTP mailhost server using the Email Settings button on Mailbox 

Properties? 
 
2.   If you receive an error message when attempting to send mail with SMTP your server may 

require authentication (ie. username and password) to send email. Use the format 
username:password@smtp.yourmailhost.com for the mailhost. 

 
 
If none of the above solve your problem, please view the up-to-date IVM Online Technical 
Support at www.nch.com.au/ivm/support.html. If that does not solve your problem, you can 
contact us using the technical support contacts listed on that page. 



 

 

Purchasing and Registering IVM 
 
IVM requires purchase and registration of a license for each installation of the software. You can 
view current pricing and purchase a licence online at www.nch.com.au/ivm/register/index.html. 
You can choose between a number of licence classes depending on the maximum number of 
lines, OGMs, and Voice Mailboxes require or whether Outbound Calls are required. Please refer to 
the table at www.nch.com.au/action/reginfo.html#ivm for details. 
 
After buying a software licence you will receive two emails. One email is the ‘Invoice/Receipt‘, 
and the other ’Software Purchase’ email contains your full 11-digit licence serial number and 
instructions on how to use this serial number to activate your software licence.  
 
This is done by selecting File -> Register Software from the IVM menu bar, entering the licence 
serial number in the ‘Step 2: Activate Serial Number’ section of the software’s registration 
window, and clicking the <Activate> button. This takes you to the Activate Software page on our 
website, where you enter your personal registration details and then click the <Activate Software 
License> button at the bottom of the web page.  
 
The licence registration and activation code details (Name - Location - ID - Key) will be displayed 
on your browser window, and they will also be automatically emailed to you.  
 
Upon receipt of your registration and activation code, enter the code details - exactly as provided 
- into the ‘Step 3: Enter the license details’ section of the Express Burn software registration 
window, and then click the <OK> button:  
 

 



 

 

NOTE: When you receive the email containing the registration and activation code you should 
heed the advice on that email and print out a copy of it immediately, and keep that hard copy in 
a safe place.  
 
 
If your key is not accepted... 
 
1. Check you have entered the Name, Location, ID and Key exactly as they appear on the email 
containing the license registration and activation code. 
 
2. If the software license was purchased a while ago for a previous version of the software, the 
registration and activation code that you are using may not work with more recent versions of 
IVM. In this case you must purchase a license upgrade at www.nch.com.au/upgrade.    
 
 
Backup IVM 
 
Once you have registered and configured the software we strongly advise you to backup IVM in 
case your hard drive fails. The easiest way to do this is to save your IVM setup as an IVR 
program file - see Loading or Saving IVR Program Files for more information. 
 
We recommend that you place a backup copy of the saved IVR program file and a copy of the 
‘ivmsetup.exe’ software installation file on a portable medium such as a CD or a USB flash drive. 
Store this backup, and a hardcopy of the email containing your registration code details, in a safe 
place for future use - in case you have to reinstall IVM following a hard drive failure, or an 
upgrade to a different computer. (We do not keep copies of registration and activation codes or 
old software versions). 
 



 

 

Software Licence Terms 
 
1.   The copyrights in this software and any audio or visual work distributed with the 

software belong to NCH Swift Sound. NCH Swift Sound reserves all rights. NCH 
Swift Sound licences the distribution and installation of this software only in 
accordance with these terms. 

 
2.   By installing, using or distributing this software you, on your own behalf and on 

behalf of your employer or principal, agree to be bound by these terms. If you do 
not agree to any of these terms, you may not use, copy, transmit, distribute, or 
install this software. 

 
3.   This software, and all accompanying files, data and materials, are distributed "as 

is" and with no warranties of any kind, whether express or implied except as 
required by law. If you intend to rely on this software for critical purposes, it is 
essential that you should test it fully prior to using it for critical applications and 
you must assume the entire risk of using the program. 

 
4.   NCH Swift Sound will not be liable for any loss arising out of the use of this 

software including, but not limited to, any special, incidental or consequential 
loss. NCH Swift Sound may not refund any amount paid for the purchase of the 
software to the purchaser of the software unless the purchaser satisfies NCH 
Swift Sound that they tested the free version of the software prior to purchase. 

 
5.   You may not use this software in any circumstances where there is any risk that 

failure of this software might result in a physical injury or loss of life. Any such 
use by you is entirely at your own risk, and you agree to indemnify NCH Swift 
Sound from any claims relating to such unauthorized use. 

 
6.   You may copy or distribute the installation file of this software in its complete 

unaltered form but you may not, under any circumstances, distribute any 
software registration code. In the event that you do distribute a software 
registration code, you will be liable to pay the full purchase price for each location 
where the unauthorised use of code occurs. 

 
7.   This software is free for evaluation use only. To use the software for professional 

purposes, you must purchase (register) a licence for each location (address) 
where the software will be used. 

 
8.   The contract arising out of this agreement is governed by the laws and courts of 

the Australian Capital Territory. 
 
 
 
 
 
 
 
 
 
IVM 
(c) NCH Swift Sound 
www.nch.com.au/ivm/index.html



 

 

Main Window 
 
Out-Going Message (Default Answer OGM) 
 
This is the default OGM that is used to answer calls. You can select the OGM using the pull down 
list. 
 
The default OGM can be overridden by the AutoHours Settings and the Line Properties. 
 
If the OGM you want to select does not appear in the pull down list, tick the "List as answer 
OGM" option from OGM Properties. 
 
You can right click on this pull down list to access the OGM menu. 
 
On/Off button 
 
Click this button to turn IVM On or Off. 
 
This setting can be overridden by the AutoHours option and the OGM Properties for the 
answering OGM. 
 
Voice Mailbox 
 
Select the mailbox you wish to view using this pull down list. 
 
You can right click on this pull down list to access the Mailbox menu. 
 
In-Coming Messages 
 
This lists all the messages in the selected mailbox. Select message by clicking on their file name. 
 
The icon next to the message will be red when the message is new. 
 
If you do not see any caller ID (or see Unknown) it means that your voice modem or telephony 
card does not support caller ID or your telephone company does not support the feature. 
 
Play (F9): Click on the Play button to play the selected message. You can also doubleclick on the 
message or press the F9 key to play. If you do not hear the playback, tick that you have setup 
the Play Device and Volume in Settings. 
 
Send (Ctrl+S): Click on the Send button to send the selected message(s) as an attachment to an 
email. You will be able to add optional text to the email after you click on the button. 
 
Delete (Ctrl+Del): Click on the Delete button to delete the selected message(s). You can select 
multiple messages by holding down the Shift or Ctrl keys while selecting. 
 
Save as Wav File (Ctrl+W) Press Ctrl+W to save the selected message(s) as wav file(s) on your 
hard drive. This is useful for legal or achive record purposes. 
 
Transfer Message to Mailbox (Ctrl+T) Press Ctrl+T to transfer the selected message(s) to a 
different Voice Mailbox. When selected you will see a list of all the Mailboxes. Select the MailBox 
and click OK. 
 



 

 

You can right click on the in-coming message list to access the Messages menu. 
 
 
 
Keyboard Shortcuts: 
 
F1            Help 

F9            Play Message 

Esc          Stop 

Ctrl+F     Off 

Ctrl+O     On 

Ctrl+S     Send Message by Email 

Ctrl+T     Transfer Messages to another Mailbox 

Ctrl+W    Save Message as Wav File 

Ctrl+Del  Delete Message 

Ctrl+F9   Play Current OGM 
 
 
 



 

 

Settings 
 
To open the Settings dialog box, select the Settings item from the menu of the IVM Main 
Window. 
 
Settings Tabs 
 
      General 
      Telephony 
      Caller ID 
      AutoHours 
      Call Transfer 
      Audio 
      Web Access 
      Mailbox - see Mailbox Properties 
      Prompts 
 
To close the Settings Box, click on the OK button. 
 
 
 
 
 



 

 

Settings - General 
 
General Options 
 
Run IVM automatically 
 
IVM can be set to run automatically when the computer starts. To enable or disable this, tick or 
untick the "Run IVM automatically as tray icon on Startup" option. If you want to use IVM for a 
permanent telephone service, you should select this option. 
 
There are many modes of running automatically which you can select in the pull down list. 
 
If you want IVM to run always irrespective of whether anyone is logged on select one of the "Run 
As Service" options. When running as a service IVM will work before logon and after log off. 
 
By default when running as a service IVM will 'show' and be accessible to all users as an icon on 
the tray of task bar. You can change this to limit it to the current user or no users. If you plan to 
use Windows Terminal or Remote Desktop you probably should restrict IVM to a local user or no 
users because 'showing' on a remote desktop can sometimes knock out local devices because 
they attempt to use the remote devices! 
 
Running as a service only takes effect the next time you restart the PC. You should also check 
that it works after restarting your computer. If you have any problems check any folders are 
accessible from the "Local System" account. If you need to send email from IVM using MAPI, you 
must change the "Log On As" password for the IVM Service. To do this, after you have set Run as 
Service, open Control Panel / Administrative Tools / Services. Double click on "IVM Service", 
select the Log On tab, select this account and then enter the name and password of the user 
account to use to send email. 
 
Bring IVM to foreground when new message is received 
 
When this option is ticked, IVM will open to the foreground when a new message is received. 
This is useful if it is important that you know someone has left a message, but you may want to 
turn it off if you are working on your computer and do not want to be interrupted. 
 
Answer Mode 
 
Answer calls after fixed number of rings 
 
This is the default option (tollsaver off). Enter the number of rings to answer after. With 
hardware that supports caller ID, you should allow at least 2 rings because caller ID information 
is transmitted between the first and the second ring. 
 
Tollsaver 
 
If the Tollsaver is enabled, IVM will wait at least 5 rings before answering if there are no 
unplayed in-coming messages. If there are new incoming-messages, IVM will answer at 3 rings. 
When using remote access you can use this feature so you will not pay for a call when there are 
no new messages if you hang-up by the fourth ring. 
 



 

 

Telephone Audio Play Process 
 
Volume Level Adjust 
 
The gain of audio playback on the telephone lines can be adjusted down or up from -8dB to 
+8dB. The default is 0dB. 
 
Tone High Pass Filter 
 
You can use a high pass filter to improve the intelligibility of audio on poor quality phone lines. 
 
The filter is a soft (3dB per octave) high pass (low cut) filter. The filter is specified in Hertz. To 
turn the filter off, enter 0Hz. 
 
Recommended settings are: 
 

Good Quality Lines - 0Hz 
Medium Quality Lines - 350Hz 
Poor Quality Lines - 1000Hz 

 
If you use the filter you might need to add additional gain to the line at the same time (see 
above). 
 
Compressor Threshold 
 
This refers to an audio dynamic range compressor (sometimes called a compander) which should 
not be confused with the Audio Compression Format. 
 
A compressor is in effect a very fast and automatic fader which attenuates the message level 
when it is above the "threshold" level. The attenuation is determined by the "compressor ratio" 
which is a ratio of input level to output level. The most extreme compression is limiting (an 
infinite ratio) which means that the mean level of the audio will not exceed the threshold level. 
The IVM compressor has a fixed ratio of 3:1 above threshold and infinite ratio (ie. limiter) above 
+3dB. 
 
A compressor can improve playback where the levels or the messages are inconsistent (too soft 
or too loud) or where the line quality is poor and louder signals are distorting. 
 
The default threshold is 0dB (almost off). If you find the levels of the playback are a problem, a 
compressor threshold of say -15dB might improve this. 



 

 

Settings - Telephony 
 
This is the list of all the telephone lines (PSTN and VoIP) currently configured for use. 
 
They should include all voice modems or professional telephony devices as well as all of the VoIP 
lines that you wish to use.  
 
Add  
 
Adds a new line device. This button displays a list of all the available telephone line devices that 
may be added. 
 
Select the New SIP based VoIP Account item to add new VoIP account details.  
 
If you are attempting to add some hardware device and do not see that item in the list then refer 
to the Knowledge Base article “My Modem or Telephony Board is not listed as a valid telephony 
device” at www.nch.com.au/kb/10045.html  on the NCH Swift Sound website. 
 
Select the device that you wish to add, then click the <Add> button.  
 
 
Remove  
 
Removes the selected line device from the configuration.  
 
Properties  
 
Change the properties of the selected line device. For setting details see Settings ~ Telephony 
~ Line Properties. 
 
 



 

 

Settings - Telephony - Line Properties - Hardware Line 
 
This is for adding devices to connect to 'real' (non-VoIP) telephone lines. 
 

Line Tab: 
 
Line Name 
 
User defined name for this telephone line. If you have multiple lines, it is useful to name each line 
so you can see clearly which line you are referring to. We recommend in multiple line setups that 
you name each line with the real number of the line. 
 
End-Of-Call Detection 
 
Use the end-of-call tone detection from both the hardware and its internal software detection. 
The default settings usually work well but if you find that calls hang up unexpectedly (during 
playback or record) or you have good hardware and want to reduce call online times, use these 
End-of-Call Tone Detection Settings. 
 
Enable end-of-call tone detection during playback. By default this is off to stop the out-going 
audio being mistaken for an end-of-call tone by cheaper voice modem circuits. If you have a 
professional telephony device and are playing long recordings you might try turning this on so 
that IVM will disconnect immediately if the caller hangs up during playback. Otherwise IVM waits 
to the end of playback. 
 
Enable software based end-of-call tone detection. By default this is on so IVM detects the end-of-
call tone even when the hardware fails to detect it. This must be on if end-of-call tone detection 
during playback is off. 
 
Call Detection Timing 
 
Most hardware takes a little time to detect end-of-call tones or DTMF tone presses. The end-of-
call or key press will only be reported after it has been recorded. To compensate for this IVM 
rewinds the recording a preset time so that the end of the recording is more exact. Because 
different hardware has different timing you may need to adjust these for optimal performance. 
 
End-Of-Call Detect Delay (ms). This is the time that IVM trims a recording back after the end of 
call tone is detected. If you find your recordings are chopped off (at the end of a recording) 
reduce this time. If you find too much of the end-of-call tone is recorded, increase this time. 
(Note: if you find it is very long make sure you have enabled software end-of-call detection as 
described above). The default value is 4500. 
 
DTMF Tone Detect Delay (ms). This is the time that IVM trims a recording back after a caller 
presses a key. If you find the recording is chopped off you can reduce this a little. Beware: a too 
short time can cause unpredictable results if a recording includes the DTMF tone itself because 
when that recording is replayed the tone will be redetected. The default value is 350ms. 
 
Distinctive Ring Detection 
 
For more information about the Distinctive Ring Detection settings, please see the Distinctive 
Ring Detection section of this manual.



 

 

Options Tab: 
 
Answer OGM 
 
By default, all lines answer starting with the default OGM selected in the pull down list of the IVM 
main window. 
 
If you are running multiple lines, and want different lines to have different start OGMs (for 
example if different lines are doing different things), then you can override the Default OGM by 
using Override Out-Going Message for this OGM  and selecting another answering OGM from the 
pull down list. 
 
Disable CID Flash for this line 
 
If you are running multiple lines, but want Caller ID Flash on only some lines, you can use this 
check box to disable CID Flash on the selected line. 
 
For more information about CID Flash see: Settings - Caller ID. 
 
Allow outbound and message forward calls 
 
When this option is ticked IVM will use this line when making outbound or mailbox message 
forward calls. Normally all lines should be ticked. If you have multiple lines and one is a priority 
incoming line that you do not want to be busy you can turn off outbound calls on the line. 
 
When making outbound calls, IVM searches for a free line in the order the lines are listed. If you 
want IVM to prefer particular lines for outbound calls you should remove all lines and add the in 
the preferred order. 
 
For more information see Outbound Autodial Calls and Mailbox Properties - Message 
Forwarding. 
 
Fax 
 
These options determine what IVM does when it detects an incoming fax. 
 
TAPI Fax Mode handoff 
 
If this option is selected, IVM performs a TAPI Mode Handoff so any other TAPI Fax Software 
running on the same computer can take control of the call. Unfortunately, no fax software on the 
market at the time of release of this software works accepts a TAPI handoff correctly. 
 
Dial this number 
 
Many fax machines will let you activate them by dialling a digit or digits when you hear a fax 
tone. IVM can do exactly that when it detects a fax call. With the "Dial... then Hang Up" option, 
IVM can dial the digits to make your fax machine turn on and answer the call. Refer to the 
manual of your fax machine for more information. 
 
For more information about Faxes and IVM, please see Fax Support. 



 

 

Settings - Telephony - Line Properties - VoIP Line 
 
For an overview of VoIP please see the topic Using Voice over IP (VoIP). 
 
To receive (or make) VoIP calls with IVM you need to add a number of virtual VoIP lines. To add 
a line, or open VoIP line properties, use the Telephony tab of Settings. Lines can have the same 
details (to receive or make multiple calls on one line) or different details (for many numbers). 
 
In order to have a VoIP number or 'SIP address' you need to sign up for a free Internet call 
server (for Internet to Internet calls) or a VoIP gateway service (for calls from real lines). See 
SIP Service Providers at www.nch.com.au/talk/sip.html for more. 
 
 

Account Tab: 
 
VoIP Account Name 
 
This is the name that is used to identify the line - for example on the logs, the status window etc. 
It can be any text but we recommend something useful like "Line 1" or "5551234567 - 1" or “Help 
Desk line“. 
 
Lines can be duplicates of the same SIP number (to handle multiple calls on the same number) or 
have different line settings and numbers for different lines.  
 
VoIP Connection Settings 
 
Number of simultaneous calls allowed 
 
SIP lines can have multiple connections at the same times. Set the maximum number of 
simultaneous calls allowed on this particular VoIP Account here.  
 
Remember that IVM treats a line as being a concept that can only have one call on it at a time. If 
you set too many simultaneous lines you could exceed the total number of lines permitted under 
your IVM license class. 
 
SIP Number (or User Name) 
 
Enter the SIP number that you were assigned when you signed up with a SIP service provider. 
 
Password 
 
Enter the password you chose or were supplied when signing up with your SIP service provider. 
 
Server (Proxy and Domain) 
 
Enter the SIP server name that was given to you by your SIP service provider. If they ask you to 
provide a port for their SIP server enter the port number after a colon (eg. 
mysipserver.com:5060). If the port number is the default 5060 you do not have to enter it. 
 
<Advanced SIP Server Settings> button 
 
The Advanced SIP Server Settings only need to be modified if your SIP provider... 
 



 

 

- uses different outbound and proxy server names, or 
- uses different a user name for server authentication. 
 
Outbound Server 
 
This is the server where you send all data to when registering your SIP line and conducting 
phone calls. 
 
Use the specified server as the outbound server - use the SIP proxy server as the outbound 
server. 
Use a different outbound server - specify another outbound server. 
Do not use an outbound server - select this option to disable the outbound proxy. This will 
essentially disable your SIP line, as you will not be able to send data anywhere on a LAN or the 
Internet. 
 
Authentication User Name 
 
This option allows a different username from the Sip Number (or User Name) used for the Sip line 
to be used to authenticate the connection to the SIP server. 
 
Use the default User ID for authentication - use the Sip Number (or User Name) defined for 
the default Sip line for server authentication. 
Use a different username just for authentication - specify another username to 
authenticate the connection to the Sip server. 
 
Click <Restore Defaults> if you want to rollback any changes that you have made to the 
Advanced Line Settings dialog. 
 
 

Networking Tab: 
 
Internet Connections 
 
These settings relate to the ability to connect over a network or the Internet. If your computer 
cannot determine what its external IP address is, you will have problems receiving and 
conducting phone conversations. People with computers behind NATs or firewalls should 
pay careful attention to this section! 
 
Most of the options here are fairly advanced, so don't change them unless you understand 
them fully. This section is intended for network administrators or like-minded individuals. 
 
Local SIP Port to listen on 
 
The UDP port on your computer that will be used to create a SIP signalling connection. The 
default port used here is 5070. If you have some other SIP software running on your computer 
you can pick another number (say 5071) to avoid a conflict. 
 
* You must open this port on your local computer's firewall. Your router should be able to handle 
opening its own ports automatically, but if it can't then you may need to setup port forwarding. 
 
Local RTP ports to listen on starting from 
 
The UDP port on your computer that will be used to for the audio connection. The default port 



 

 

here is 8000. If the port is in use then the software will find the next available port. 
 
* You must open this port on your local computer's firewall. Your router should be able to handle 
opening its own ports automatically, but if it can't then you may need to setup port forwarding.   
 
Use uPnP to find external IP address 
 
Uses the Universal Plug 'n' Play protocol to determine your external IP address. Note that if you 
are using Microsoft Internet Connection Sharing (ICS) over a LAN, you may need to enable uPNP. 
To do this, on the computer running Internet Connection Sharing select Start -> Settings -> 
Control Panel -> Network Connections and then right click on the Internet connection. Select 
Properties, go to the Advanced tab, and tick the option "Allow other network users to control the 
shared connection". 
 
Use STUN servers to find external IP Address and Port 
 
Uses the "Simple Traversal of UDP protocol through NAT" technique to ask a server on the 
Internet if you are behind a NAT or firewall, and if so, what your external IP address is. The 
default server addresses listed only need to be changed if both STUN servers are offline - in other 
scenarios you can leave them as they are. 
 
Use static IP address and static mapped ports (Advanced Options) 
 
This is where you can enter your external IP address and SIP/RTP ports if your computer or the 
gateway computer on your network connects to the Internet using a static IP address. Again, the 
default SIP and RTP port settings to try here are 5070 and 8000. 
 
If you are having problems with SIP calls and suspect the issue is network-related, then click the 
<Run Network Setup Wizard> button in order to launch a wizard that will guide you through the 
network troubleshooting process. 
 
 

Advanced Tab: 
 
Quality / Bandwidth 
 
These settings relate to the choice of codec when making a phone call.  
 
Prefer lower bandwidth (but with lower audio quality)  
 
This options forces the use of a low bandwidth codec. Useful for slower Internet connections.  
 
Use default settings (Recommended)  
 
This option allows the software to select the choice of codec. The software will make the best 
compromise between quality and bandwidth.  
 
Prefer higher quality audio (but using more bandwidth)  
 
This option forces the use of a high bandwidth (and high quality) codec. Useful for faster Internet 
connections.  
 
 



 

 

SIP Message Logging 
 
Log all SIP messages  
 
This will log all the SIP messaging data into a file.  
 
Log all RTP (audio) packets  
 
This will log all audio data that is sent and received.  
 
Click the <View Logs> button to view the folder where these logs are stored.  
 
SIP and RTP data are both stored in the one file for convenience. Files are split up according to 
day in order to avoid creating large files.  
 
 
 

Options Tab: 
 
Answer OGM 
 
By default, all lines answer starting with the default OGM selected in the pull down list of the IVM 
main window. 
 
If you are running multiple lines, and want different lines to have different start OGMs (for 
example if different lines are doing different things), then you can override the Default OGM by 
using Override Out-Going Message for this OGM  and selecting another answering OGM from the 
pull down list. 
 
Disable CID Flash for this line 
 
If you are running multiple lines, but want Caller ID Flash on only some lines, you can use this 
check box to disable CID Flash on the selected line. 
 
For more information about CID Flash see: Settings - Caller ID. 
 
Allow outbound and message forward calls 
 
When this option is ticked IVM will use this line when making outbound or mailbox message 
forward calls. Normally all lines should be ticked. If you have multiple lines and one is a priority 
incoming line that you do not want to be busy you can turn off outbound calls on the line. 
 
When making outbound calls, IVM searches for a free line in the order the lines are listed. If you 
want IVM to prefer particular lines for outbound calls you should remove all lines and add the in 
the preferred order. 
 
For more information see Outbound Autodial Calls and Mailbox Properties - Message 
Forwarding. 



 

 

Settings - Caller ID 
 
These options will notify you of the caller's number whenever a call is received by IVM. 
 
To use caller ID with normal telephone lines: 
 
1. Voice modem/telephony card must support caller ID (not all do). 
2. The phone company must send caller ID information (sometimes you need to pay your phone 

company for this feature). 
3. If you are using a PBX extension, your PBX must carry the caller ID to the IVM extension. 
4. You must answer after 2 rings (the caller ID information is carried between the first and 

second ring). 
 
All VoIP systems support caller ID. 
 
Flash Caller ID of incoming call on screen 
 
When this option is ticked, IVM will display the caller number and name of any caller as a bubble 
on the tray of the task bar whenever the phone rings so you can know who is calling. It does this 
even when IVM is in Off mode. 
 
Announce Caller Name through Speakers 
 
When this option is ticked, IVM 'says' the name of any caller through the speakers whenever the 
phone rings so you can know who is calling. It does this even when IVM is in Off mode. 
 
If you don't see any voices in the pull down list it means you do not have a speech engine 
installed. You can download one of the text-to-speech engines using the links at 
www.nch.com.au/speech/index.html (the Microsoft engine is free). 
 
Announce caller's number as digits  
 
Some speech engines may normally say the number as a whole number (eg. “Forty eight million, 
one hundred and seventy two thousand, three hundred and ninety six”) rather than as a list of 
digits (eg. “ 4 - 8 - 1 - 7 - 2 - 3 - 9 - 6“). Enable this option to force the caller's number to be 
spoken as a list of digits. 
 
Caller Blocking 
 
This feature is used to block callers from particular numbers (for example to block abusive 
callers) or even block callers with caller ID turned off. 
 
This feature works even when IVM is off. But you must answer after the second ring (because 
caller ID information is sent between the first and second ring). 
 
Block Numbers 
 
Enter the number that you want to block. To block more than one number list the numbers 
separated with ; (a semi-colon). You can also specify a number prefix - in which case IVM blocks 
all calls starting with that number. 
 
 
 



 

 

Block Private or Unknown Numbers 
 
When this option is enabled any call with caller ID turned off, blocked, or not carried by the 
network will be blocked. 
 
If call is blocked... Disconnect the call immediately 
 
If selected, IVM will pick up the call, play a short tone and then hang up on any blocked call. 
 
If call is blocked... Answer with this OGM 
 
If selected, IVM will answer the call with a special OGM which you can record. For example, you 
might select an OGM with the message "For security reasons we cannot accept calls with caller ID 
turned off. Please call from another phone which supports caller ID." 



 

 

Settings - AutoHours 
 
The IVM AutoHours schedule can be used to make IVM answer automatically only after business 
hours, to use different OGMs at different times of day or to change the number of rings to wait 
for at different times of day. This will save you having to manually turn IVM On/Off or select OGM 
every day. 
 
Similar results can be obtained using the OGM Properties Date-Time Scheduling, but the system-
wide AutoHours Settings are simpler. 
 
To use AutoHours tick the "Use AutoHours" box and enter the applicable hours for weekdays, 
Saturday and Sunday. Then select what you want IVM to do between these hours and what you 
want IVM to do outside these hours. 
 
Typical settings for a normal business offices are: 
 

Weekdays          09:00:00          17:00:00 

Saturday            09:00:00          12:00:00 

Sunday              00:00:00          00:00:00 

Between these hours: Do not answer calls 

After hours: Answer with default OGM 
 
NOTE: For AutoHours to work, the IVM <On> button on the main windows must be clicked "On". 
 
 
 
 
 



 

 

Settings - Call Transfer 
 
Transferring Calls 
 
Before changing these settings you must read the topic Transferring Calls to understand call 
transfer. 
 
Blind Transfer 
 
Enter the digits that IVM needs to dial to initiate a blind transfer (usually flash pause '!,') and any 
suffix needed to complete the call (not often required). 
 
If your TAPI hardware can transfer calls using hardware, you can tick the "Use TAPI hardware 
box". Otherwise, leave this box unticked to make the transfer by simply dialling the digits. 
 
Confirmed or Answer Detect Transfer 
 
Enter the digits that IVM needs to dial to initiate a confirmed or answer detect transfer (usually 
flash pause '!,'), the digits to dial if the call is accepted before hanging-up (usually nothing) and 
the number to dial if the call is rejected (usually another flash). 
 
Simulate call transfers as a 3 party conference call 
 
If your telephone company or PBX does not support call transfers but does support a conference 
call, IVM can use this feature to "simulate" a transfer. When you tick the "Simulate call transfers 
as a conference call", IVM will run through the normal steps to setup a conference call (thinking it 
is transferring the call) and then stay online for the call duration. (Note: Your phone line will be 
busy for the call duration). 
 
This option is usually only effective with confirmed transfers, not blind transfers. 



 

 

Settings - Audio 

 
Recording Messages 
 
Maximum Record Time: The default maximum record time for a message is 30 seconds. 
 
Record Detect Level: This is for automatic voice activated recording and for end of call (silence) 
detection. If messages are not recorded fully, reduce this level (to say -36dB). If messages do 
not stop at the end of the call, increase this level (to say -15dB). 
 
Delete Messages: IVM automatically deletes in-coming messages after a set number of days. You 
can change the number of days using this setting. A value of 0 means the messages will never be 
automatically deleted. 
 
Set Audio Compression Format 
 
If you are sending messages as attachments to an email, or uploading to an Internet access web 
page, you can use a number of different codecs to compress the audio (reduce the file size and 
download time). The recommended format is GSM 6.10 or DSP GROUP TRUESPEECH. For others 
see our codecs information page www.nch.com.au/acm/index.html. 
 
Play Device and Volume 
 
This is the device (sound card) that IVM uses to play messages through your speakers. If you 
have more than one sound card you can select the sound card to use with this pull down list. You 
can also adjust the playback volume.  
 
Call Announce and Call Screen Device and Volume  
 
This is the device that IVM uses to screen calls (see Mailbox Properties) and to play call 
announce messages (see OGM Properties - Advanced). You might want call screening or call 
announcements to be louder.  



 

 

Settings - Web Access 
 
IVM supports web access which, if enabled, lets you log onto the IVM using any ordinary web 
browser over your network or even the Internet (if you set your firewall to allow it). After you log 
in with your a mailbox remote access code you check the messages for that mailbox remotely. 
 
To activate this feature tick the "Enable web control..." option and make sure the mailbox has 
remote access enabled with a suitable unique access code for each mailbox (see Mailbox 
Properties). 
 
To offer the web access control panel this software runs as a mini web server. It runs on port 82 
(the normal port is 80 but IVM does not use this in case you have another web server on the 
same computer). 
 
To access your mailbox use one of the following address formats in your Internet browser. 
 
http://localhost:port    eg. http://localhost:82 (if IVM is running on this computer) 

http://computername:port    eg. http://mycomputer:82 (for use on a local computer network) 

http://privateip:port    eg. http://192.168.0.1:82 (for use on a local computer network) 

http://publicip:port    eg. http://212.137.22.14:82 (for Internet use) 

http://domainname:port    eg. http://vrs.mycompany.com:82 (advanced option - if you have a 
DNS) 
 
You need to make sure your firewall is not blocking the port (default port 82). Refer to your 
firewall settings to check the correct TCP/IP port is opened. 
 
Speak to your network administrator about any networking problems you have. They can usually 
quickly fix routing or firewall problems. 
 
 
 
 
 
 

Settings - System Prompts 
 
The IVM System Prompts can be changed using the Prompts tab of Settings. To change a 
prompt, select the prompt, click on the Change button and then select Record / Load Wav/mp3 / 
Synthesize Voice from the menu. 
 
Advanced Option. If you need two sets of prompts (for example one English and another French) 
create a copy of the System Prompts folder (C:\Documents and Settings\All Users\Application 
Data\NCH Swift Sound\IVM\System Prompts) somewhere else on your hard drive. For example 
(C:\Documents and Settings\All Users\Application Data\NCH Swift Sound\IVM\French Prompts).  
 
Then at any point during the call to 'switch on' French prompts use the variable 
SystemPromptsFolder. In the Advanced tab of OGM Properties in the "Set local call variable" field 
enter "SystemPromptsFolder=C:\Documents and Settings\All Users\Application Data\NCH Swift 
Sound\IVM\French Prompts". 
 



 

 

Mailbox Properties 
 
Open Mailbox Properties using the menu item Mailbox->Properties, or <Settings> -> Mailbox -> 
Properties. 
 

General 
 
Mailbox General Properties 
 
Use Call Screening 
 
If you tick this box, you will be able to monitor the callers' messages as they are being recorded 
through your computer speakers. 
 
To use call screening, you must also select the Call Screen Device and volume from Settings - 
Recording. 
 
Sound beep through speakers when new messages 
 
When the "Sound beep through speakers when new messages" option is selected, IVM will play a 
short tone every 15 seconds when there are new messages in the mailbox. This is useful to notify 
you when there are new messages. 
 
Mailbox Message Notification  
 
These features are normally used with a PBX to dial a number to turn on or off a mailbox light 
(see Connecting to Telephone Key Systems or PBXs). It can also be used to dial a pager 
number to set a pager message.  
 
Enter the number to dial, followed by a comma followed by any DMTF digits to dial after the call 
is answered. You can use additional commas to add 500ms delay each comma. 
 
When a new message arrives, dial  
 
Dial this sequence when a new message has been left in the mailbox. 
 
After a message is checked, dial  
 
Dial this sequence when a message has been played by someone checking their messages via the 
telephone. 
 
Mailbox Personal Greeting  
 
Each mailbox can have a personal greeting that will be played immediately before the message is 
recorded only if the active command is set to play the personal greeting. In a single mailbox 
setup, you would not use this (the OGM would be the greeting), but with multiple mailboxes you 
might want to use a personal greeting for each mailbox. 
 
Play Greeting  
 
Click on the <Play Greeting> button to play the current mailbox greeting. Click on the button 
again to stop playback. 
 



 

 

 
Change Greeting Audio  
 
Click on the <Change Greeting> button to record a new greeting, import a wav or mp3 file, 
synthesize speech (text-to-speech) or restore to the default greeting. 
 
To synthesize speech, you must have a speech engine installed. If a speech engine is not already 
installed with your version of Windows or if you want to add different voices, you can download 
one of the text-to-speech engines using the links at www.nch.com.au/speech (The Microsoft 
engine is free).  
 
Minimum Voice Mail length  
 
IVM will treat any Voice Mail that is shorter than the set minimum length as being too short, and 
will delete it without any further action.  
 
Use system default  
 
Use the system default, usually about 3 seconds, for this Mail box.  
 
Customized for the Mail Box  
 
Use this value for the minimum for this Mail Box.  
 
 
 

Delivery 
 
Remote Access 
 
Tick this box and enter an access code if you want to be able to dial into IVM and listen to 
messages by telephone or by Internet using your web browser. 
 
For more information about the telephone remote access feature, please see: Remote Access 
by Telephone. For more information about checking mailboxes by Internet see Web Access. 
 
NOTE: The access codes must be unique for each mailbox. No mailboxes should have the same 
access code. Usually on large mailbox systems the access code contains a mailbox number and 
password (eg. mailbox 22 could have access code 22123). 
 
If you tick the "Read Time of Message" option, the caller will hear the time that the message was 
called when they use Remote Access. 
 
Send to Email 
 
If this option is selected IVM will automatically send the message, or a notification of receipt of 
the message, to an email address. 
 
To receive messages by email tick the "Send to Email" box, enter your email address and tick 
"Send audio file as attachment". If you only want to receive notification of receipt of a message 
(not the actual message), untick the "Send audio file as attachment" box. 
 
If you are sending messages by email over slow Internet connections, you should consider setting 



 

 

the audio compression format to reduce file size. See Settings - Recording for more 
information about settings the compression codec. 
 
You can send emails to multiple addresses by listing them separated with commas. Additionally 
variables, normally retuned by a plugin, can also be used (eg. %emailaddress%). 
 
This option can be used to send email notifications by SMS or a paging service. You need to use 
an email->SMS gateway (eg. www.kapow.co.uk). Change the subject and template text using the 
email settings as required by your email->SMS gateway. Of course, you should not attach audio 
to an SMS email! 
 
To change the way emails are sent (MAPI/SMTP) or to change the default email subject line or 
text, click on the "Email Settings" button. See Email Settings for more information. 
 
If you have a speech-to-text engine installed (eg. Dragon Naturally Speaking) IVM can be set to 
automatically transcribe the messages with the speech recognition technology. To enable this, 
tick the "use speech recognition" option and select the engine in the pull down list. Emails will 
then be sent with the transcription. Note that the default Microsoft engine is not good enough 
and that because almost all messages will be with "untrained" voices even with the best engines 
available today there will be many errors. 
 
If you have problems with the send to email feature see Troubleshooting Problems for some 
solutions. 
 
Upload to Internet Web Page using FTP 
 
IVM can automatically create a web page on your web site where you can listen to your 
messages online. 
 
To use this feature you must have a space on a web server which will be used for the web page. 
Most Internet Service Providers (ISPs) allow their customers to have some space to have their 
own web site free (usually subject to a maximum number of MB). If you do not know if your ISP 
offers the service, call your ISP and ask whether they offer that service. 
 
IVM uploads the page (and the recordings) using FTP. To upload a file you need to know the ftp 
server name (eg. ftp.yourdomain.com), your user name, your password and the directory into 
which you want to upload the page (eg. /home/yourusername/www). If you do not know these, 
please contact your ISP. 
 
Tick the "Upload to Internet Webpage using FTP" option and enter the ftp details. 
 
The name of your page will be based on your mailbox name. It will be in lower case with all 
spaces replaced with '_' characters and with the '.html' suffix. For example, if the mailbox is 
called "Mailbox 1" the webpage to access will be "mailbox_1.html" on your website. 
 
If you are accessing the page over slow Internet connections, you should consider setting the 
audio compression format to reduce file size. See Settings - Recording for more information 
about settings the compression codec. 
 
You can apply a security password to the site if required. Speak to a web designer for more 
information. 
 
NOTE: You must not have any other wav files in the same directory used by IVM 
because IVM will delete any unidentified wav files (it will think they are outdated 



 

 

messages). 
 
Send to (LAN) Folder 
 
When this option is ticked, IVM copies the message (as a wav file) to any folder. This can be on 
the local computer or on the Local Area Network. This option is useful if you want to collect voice 
mail over your computer network. Create (shared) folders for each voice mail box. When IVM 
receives a message it will copy the wav file to that folder. The user can have a link on their 
desktop to that folder so they can check their messages at any time from their computer. 
 
 
Forward to Telephone Number 
 
When this option is selected, IVM will automatically dial a phone number after it receives new 
messages in the mailbox and offer the option to listen to the message. 
 
You can also set the number of times IVM will attempt to forward the message and the wait time 
between calls. 
 
If the "AutoAnswer" option is ticked, IVM will automatically detect when the call is answered and 
play the single message directly. This is useful if it is possible that a phone with an answering 
machine will answer the call. Even though the menu is not played at any time during the 
message the menu commands for delete and/or transfer message can be used (see Remote 
Access by Telephone). 
 
IVM uses ring-tone and silence detection to tell if a call is answered in AutoAnswer mode. The 
timing settings can be adjusted using the Outbound Autodial Calls Settings. 
 
The Forward to Telephone feature can also be used with some pager systems but remember to 
set number of attempts to 1. 
 
Before IVM can forward messages by telephone at least one line must have "Allow outbound and 
message forward calls on this line" ticked on the Options tab of the line’s Properties in Settings - 
Telephony.  
 



 

 

Email Settings 
 
Email Settings can be opened by clicking on the "Email Settings..." button from Mailbox Properties 
or from Send Email. 
 
 
Sending using a SMTP Server  
 
You must enter the SMTP mailhost used by your ISP for sending of mail (call them if you do not 
know it) and your email return address. If you have a problem when using SMTP, try sending an 
email manually from the main window of IVM to view progress and errors. 
 
If when using SMTP you receive an error message, it might be that your server requires an 
authenticated login (a username and password) to send email. If this is the case, check (tick) the 
“Server requires authentication” box and enter your User Name and Password in the boxes 
provided. 
 
 
Send directly to other side (work as own SMTP Server)  
 
Email is sent directly by IVM using a simple internal SMTP server.  
 
 
Email Template Text 
 
When IVM sends an email, the subject line and email body text is created from a template text. 
You can modify this text as required. The variables %date%, %time%, %cid%, %callername%, 
%mailboxname%, %linenumber%, %linename% and %callsequenceno% can be included in the 
text in addition to any variables entered by the caller. 
 
Example: 
 
Subject    IVM Message Mailbox: %mailboxname% CID: %cid% %callername% 
 
Attached is a message received in your voice mailbox by the IVM Telephone Attendant. 
 

Date: %date% 
Time: %time% 
CID: %cid% 
Caller: %callername% 
Mailbox: %mailboxname% 

 
Open the attachment to listen to the recording. 
 
 



 

 

OGM List 
 
The Out-Going Messages List can be opened by selecting the "Out-Going Messages List" item 
from the OGM menu. 
 
The OGM List is useful for managing all the OGMs in the system. Some OGMs (those that are not 
answering OGMs) can only be accessed through the OGM List. 
 
Play 
 
Click on the Play button to play the current Out-Going Message. To stop, you can click on the 
button again. 
 
New 
 
To create a new OGM, click on the "New OGM" button and enter the name of the new OGM. 
 
To save you time when creating many similar OGMs, the New OGM function will duplicate the 
properties of the selected OGM into the new OGM. Before you click on the New OGM button, 
select the old OGM that you want to use as a base for the new OGM (the one that is most 
similar). This saves time when creating a large number of similar OGMs. 
 
A relative path can be specified with the new OGM's name. In this way OGMs may be copied from 
one folder to another. 
 
Examples: 
• Entering ..\OGM 1 places the OGM named OGM 1 into the folder one level up. 

• Entering Answer\OGM 2 places the OGM named OGM 2 into the folder Answer. 
 
 
Clone OGM 
 
This is the same as New OGM. It is included to make it clear that the current OGM settings are 
cloned. 
 
Delete 
 
Click on this button to delete the selected OGM. 
 
CAUTION: You must change manually all references to this OGM before deleting the OGM. 
 
Rename 
 
Click on this button to rename the selected OGM. 
 
CAUTION: You must change manually all references to the OGM. 
 
Refresh 
 
Redraws the list. 
 
 
 



 

 

Report 
 
Selecting Report creates and opens a document listing all the OGMs with there scripts, menus 
and other properties. This is very useful when working with very large IVR systems. The report 
can be saved, copied or printed.  
 
Properties 
 
Click on the Properties button to change the properties for the selected OGM. 
 
For more information, please see OGM Properties. 
 
 
 
List Ordering 
 
By default the list of OGMs are listed in alphabetical order. Alternatively the list can be ordered in 
'logical' order. This starts with the current answering OGM and lists then OGMs making an 
attempt to follow the menu structure. This logical order can sometimes make it easier to follow 
the system. 
 



 

 

OGM Properties 
 
To open the OGM Properties dialog box, select the Properties item from the OGM menu of the 
IVM Main Window. 
 
OGM Properties Tabs 
 
      Message 
      Key Response 
      Date-Time / ID 
      Advanced 
 
To close the OGM Properties dialog box, click on the OK button. 
 
 
 
 
 
 
 
 

OGM - Message 
 
Out Going Message Audio 
 
Play Message 
 
Click on the Play Message button to play the current message. To stop, click on the button again. 
 
Change Message Audio 
 
Click the Change Message Audio button to record the message, import a wav or mp3 file or to 
synthesize speech (text-to-speech). 
 
To synthesize speech, you must have a speech engine installed. If a speech engine is not already 
installed with your version of Windows or if you want to add different voices, you can download 
one of the text-to-speech engines using the links at www.nch.com.au/speech/index.html (the 
Microsoft engine is free). 
 
End of the Message 
 
This box determines what IVM does after the Out-Going Message has played if there has been no 
other interaction from the caller. 
 
Wait 
 
This is the silent wait time to wait for the caller to press keys. Under ISO/IEC13714 
(www.nch.com.au/ivm/iso13714.html) this should be between 3 and 10 seconds depending on 
the menu complexity. 
 
If the OGM asks the caller to leave a message, or is intended to sequence directly to another 
OGM without any other input from the caller, set the time to 0. 
 



 

 

Repeat 
 
This is the number of times that the OGM is repeated if the user fails to enter anything. 
 
If user input is expected the recommended value is 2. 
 
If user input is not expected (for example if OGM asks the caller to leave a message, or it 
sequences directly) then set this value to 0. 
 
Then 
 
This is the Active Command  to execute at the end of the Out-Going Messages (after any 
required wait or repeats). 
 
If the OGM asks the caller to leave a message, the active command would be "Leave Message for 
Mailbox..." with the "Use personal greeting" option not selected. 
 
If the OGM is a sequence OGM, the active command would be "Go to OGM...". 
 
If the OGM really needs the caller to input information, the active command would most likely be 
"Goodbye (Polite Hang-up)" after a wait and number of repeats. 
 
Script Notes 
 
This field can be used for any purpose. It is recommended that you paste the message script into 
this field because this will make it much easier to see what each OGM asks. 
 
Where you use the synthesize speech option, the synthesized speech text will automatically be 
placed in this field. 
 
List as an Answer OGM 
 
To simplify the main window, and to reduce the likelihood of the user accidentally selecting the 
wrong default start OGM, you can select which OGMs will be listed as "Answering" OGM, that is, 
which OGMs can be used as the very first OGM at the start of the call. 
 
If an OGM is not suitable to be the first OGM a caller hears, untick the "List as an Answer OGM" 
box. 
 
 
 
 
 
 



 

 

OGM - Key Response 
 
IVM has 2 key response modes - a single digit menu option and data entry for 1 or more digits 
(usually followed by the # key). 
 
Menu (single key press) 
 
When this option is selected, IVM will execute an Active Command when the caller presses a 
key. 
 
For more information about using menus, please see the topic Using Menu Options. 
 
Data Entry (variable) 
 
When this option is selected the caller can enter a number (1 to 16 digits) followed by the # key. 
The number is then validated and then stored in a variable which can then be used later in the 
call. 
 
For more information about data entry, please see the topic Data Entry. 
 
IVM can validate the entry by range (minimum and maximum) or using a comma delimited list 
(for example to check an access code). 
 
If the data entry dial string is from an automated system (like a PBX) the "Use special digits 
mapping function" can be enabled. Click settings to enter the string. A parsing string like 
X111X222 will map the second to fourth digits to variable 1 and the sixth to eighth to variable 2. 
This is useful for decoding PBX in band signalling (see Connecting to telephone key systems 
or PBXs). 
 
When the caller has entered the maximum number of digits or the caller presses the # key the 
"Press '#'" active command is executed. To use data entry, you must select a valid active 
command for # or End. 
 
If you need to allow the # key during data entry (and to stop it being used as the data-entry-
terminator) you can tick the option 'Allow # in data entry'. Then data entry is only terminated by 
the maximum number of digits being reached and if # is pushed it becomes part of the entered 
data. 



 

 

OGM - Date-Time / CID 
 
Date-Time Validity Checking 
 
Use this option to change the way a call proceeds depending on the date, time or week day. 
 
This can be used to have different call paths for business hours, to have particular OGMs 
scheduled to commence or expire on set dates (for example, for seasonal messages or to 
correspond with promotions) or many other date-time related functions. 
 
Dates are entered in the format YYYY-MM-DD and times in HH:MM:SS. 
 
Use Number ID Validity Checking 
 
Use this option to change the way a call proceeds depending on the Caller ID (the number of the 
caller), the Dialled ID* (the number that the caller dialled) or the Distinctive Ring Number** 
(DRN). 
 
To use the caller number id, your telephony hardware (eg. voice modem) must support caller ID 
(check its manual) and you should set IVM to answer after at least 2 rings. 
 
This feature can be useful to detect which area the caller is calling from (based on the start 
numbers of the caller ID) and to change the OGM accordingly. This feature can also be used to 
"ban" certain numbers from the system. 
 
NOTES: 
* Dialled Number ID is only available with special telephone networks and hardware. Consult a 
telecommunications expert for more information. 
 
** For more information about the Distinctive Ring Number (DRN) see Distinctive Ring 
Detection. 
 
Both date-time validity checking and caller ID validity checking occur before the OGM starts so 
you can skip through a whole chain of OGMs without the caller being aware of this. This is useful 
if you need more complex validity requirements. Take care to avoid circular loops! 
 



 

 

OGM - Advanced 
 
Play external wav/mp3 file 
 
Usually IVM copies any wav or mp3 file into the system when you use the "Change Message 
Audio" button from the OGM Properties Message tab. However sometimes it is necessary to play 
a file directly from your hard drive where, for example, that file is regularly changed by another 
program (for example the AudioTime programmable audio recorder and player - see 
www.nch.com.au/atime/index.html). 
 
To use an external wav/mp3 file as the message, click on the "Play external wav/mp3 file" and 
then click browse. 
 
 
Read out number after OGM 
 
IVM can read out numbers from a variable that has been entered by the caller or returned from a 
plugin (eg. database results). This can be used to confirm data entry (eg. "the number you 
entered was...") or to return information to the caller (eg. "your account balance is..."). 
 
To use this, tick the "Read Out Number" box and enter the variable name. The variable name  
must not include the % characters. 
 
You can also select the way IVM reads numbers. For example if the number to read was "1234", 
"Digits" would be "one two three four", "Number" would be "one thousand two hundred thirty 
four", "Dollars & Cents" would be "twelve dollars thirty four cents" and "Dollars Whole" would be 
"one thousand two hundred thirty four dollars". 
 
The number is read at the end of the OGM. Usually this OGM would then be chained onto a 
further OGM using the "Go To" active command for the End of Message. 
 
 
Text to Speech Voice Synthesis 
 
When this option is selected, IVM will use the selected text-to-speech engine selected in the pull 
down list next to this option to synthesise the speech. 
 
The text used is text entered in the "Speech/Notes" section under the Message tab of OGM 
Properties. You can include variables (circumfixed with %) in the script if required (eg. to read 
data returned from a plugin). 
 
To synthesize speech, you must have a speech engine installed. If a speech engine is not already 
installed with your version of Windows or if you want to add different voices, you can download 
one of the text-to-speech engines using the links at www.nch.com.au/speech  (the Microsoft 
engine is free). 
 
 
Add entry to special log 
 
IVM can create special logs of calls that play a particular OGM. including any data that the caller 
may have entered. These can be used to count the callers (and caller IDs) of callers that select a 
particular option, or to record the data that the caller has entered. 
 



 

 

To create a Special Log, tick "Add Entry to Special Log". Enter the log file name and the log line 
format. The format can include any data field variables (between two % characters). You can 
also use the call variables %time%, %date%, %cid%, %callername%, %linenumber% and 
%linename%. If you are intending to import the log directly into a database or spreadsheet, we 
recommend you use commas to delimit each variable. (This is particularly useful when using IVM 
for customer surveys). 
 
To open, print or delete logs, select the "View or Print Call Logs" item from the File menu. 
 
 
Announce call through speakers 
 
If you tick this and click browse to locate a file on your hard drive, whenever the caller reaches 
the current OGM, the wav file will be played through the speakers. 
 
Often this can be used to play a wav file which might be a message "Call for Joe Bloggs... Please 
pickup line...". In the interim you select OGM audio which would probably be on-hold music or 
messages. When Joe Bloggs picks up the call, he presses a key which would be set using the Key 
Response line to make IVM hang-up immediately. That way the caller thinks they have been 
transferred but it really has just been on the same line. If the call is not picked up after the 
duration of the OGM on-hold music or messages file, IVM could be set to take a message. 
 
 
Set Variables 
 
When each OGM starts IVM can set variables which can be used later in the call (local call 
variables) or at any time in future (global variables). 
 
The set string needs to be in the form variable=data. For example language=french will mean 
later you can use %language% almost anywhere in call flow settings and french will be 
substituted. Optionally more variables can be set separating each with & (eg. 
variable1=data&variable2=otherdata). 
 
The local call variables apply to this call and last for the duration of the call only. 
 
Global variables last forever (or until you set them to blank) and apply to other calls. They are 
one way something somebody does on one call can change other calls. 
 
The other two common ways of setting local call variables are data entry and plugins. Global 
variables are commonly set or changed by other programs using an IVM command line option. 
See www.nch.com.au/ivm/sdk.html for more. 
 
 
Run Exe or Run IVM Plugin 
 
IVM can run an exe or plugin as the OGM starts. This can be used to run another program to 
open almost any file (a movie mpg for example), or an exe or plugin which could do almost 
anything on your computer. 
 
For more information about running exes or plugins, please see the topic Using IVM Plugins. 
 
Tick this option then browse to the program you want to use. You can add command line 
arguments to the end of the exe if required. The command line arguments can include caller data 
entry variables, circumfixed with the % character or the call variables %time%, %date%, 



 

 

%cid%, %callername%, %linenumber% and %linename%. 
 
IVM can also run special IVM Plugins -  an external program that IVM can run to process or 
obtain data. For example, if you are making an interactive voice response system to tell the caller 
the current temperature, a plugin could be used to read from the hardware and return the 
temperature to IVM. A plugin could also be used to restart the computer, access a database, 
process credit card orders and more. For more information about using plugins, please see the 
topic Using IVM Plugins. 
 
If the exe is a plugin, tick "Is IVM Plugin Process". You must not tick "Is IVM Plugin 
Process" unless the process is a true plugin! 
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